
Integration between
Tekla Structural Designer 
and Tekla Structures

June 2023

©2023 Trimble Solutions Corporation



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  2 
 

Contents 
 

 

 

 

1.0 Overview of Integration ........................................................................................ 5 

2.0 Project Workflows ................................................................................................. 6 

2.1 Initial Scheme Stage.......................................................................................... 6 

2.2 Detailed Design ................................................................................................. 7 

2.3 Construction Stage ........................................................................................... 7 

2.4 Workflows for integration ................................................................................. 7 

2.5 Where to start? .................................................................................................. 8 

3.0 Minimum versions for integration........................................................................ 9 

3.1 Minimum version for neutral file transfer ........................................................ 9 

3.2 Minimum version for model file transfer .......................................................... 9 

3.3 Minimum version for Tekla Structures analysis model .................................. 9 

3.4 Minimum version for Rebar transfer ................................................................ 9 

3.5 Does software need to be on the same computer? ........................................ 9 

4.0 Starting the workflow with Tekla Structural Designer ...................................... 10 

4.1 Creation of the Tekla Structural Designer Model .......................................... 10 

4.2 Deliverables ..................................................................................................... 11 

4.3 Do you need to create an export? .................................................................. 11 

4.4 Importing a model into Tekla Structures using .tsmd model files ............... 19 

4.5 Importing a model into Tekla Structures using .cxl neutral files ................. 32 

4.6 After import ...................................................................................................... 41 

4.7 Returning information from Tekla Structures to Tekla Structural Designer 60 

4.8 Subsequent transfer from TSD into TS .......................................................... 78 

5.0 Starting the workflow with Tekla Structures ..................................................... 84 

5.1 Overview .......................................................................................................... 84 

5.2 Limitations ....................................................................................................... 84 

5.3 A & D models Command ................................................................................. 85 

5.4 Exporting a model from Tekla Structures to Tekla Structural Designer .... 106 

5.5 Returning information from Tekla Structural Designer to Tekla Structures

 108 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  3 
 

6.0 Managing the conversion process .................................................................. 111 

6.1 Overview ........................................................................................................ 111 

6.2 Preview Conversion ...................................................................................... 112 

6.3 Correcting Profile Conversion ...................................................................... 114 

6.4 Correcting Material Conversion ................................................................... 120 

6.5 Correcting Rebar Grade Conversion ........................................................... 122 

Appendix 1 - Section Code References ..................................................................... 125 

USA Imperial ............................................................................................................ 125 

USA Metric ................................................................................................................ 127 

UK Metric .................................................................................................................. 129 

European Metric ....................................................................................................... 132 

Singapore / Malaysia................................................................................................ 133 

Australian Metric ...................................................................................................... 134 

South Africa Metric .................................................................................................. 135 

Indian Metric ............................................................................................................. 136 

Canadian Metric ....................................................................................................... 137 

Japanese Metric ....................................................................................................... 138 

Chinese Metric ......................................................................................................... 139 

Hyundai .................................................................................................................... 140 

Nippon ...................................................................................................................... 141 

Korean ...................................................................................................................... 142 

Taiwan ...................................................................................................................... 143 

Thailand .................................................................................................................... 144 

Appendix 2 - Group Name References ....................................................................... 145 

USA Imperial ............................................................................................................ 145 

USA Metric ................................................................................................................ 146 

UK Metric .................................................................................................................. 147 

European Metric ....................................................................................................... 149 

Singapore / Malaysia................................................................................................ 150 

Australian Metric ...................................................................................................... 151 

South Africa Metric .................................................................................................. 152 

Indian Metric ............................................................................................................. 152 

Canadian Metric ....................................................................................................... 153 

Japanese Metric ....................................................................................................... 153 

Chinese Metric ......................................................................................................... 154 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  4 
 

Appendix 3 - List of created parameters .................................................................... 155 

Analysis Result Parameters .................................................................................... 155 

Reinforced Concrete Specific Parameters ............................................................. 158 

General Parameters ................................................................................................. 159 

Appendix 4 - Object Types .......................................................................................... 161 

Members (Parameter : TSD Member Type (TSD_MBR_TYPE)) ............................. 161 

Slabs (Parameter : TSD Slab Type (TSD_SLAB_TYPE))........................................ 163 

Walls (Parameter : TSD Wall Type (TSD_WALL_TYPE)) ....................................... 163 

 

 

 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  5 
 

1.0 Overview of Integration 

 
 

When considering the integration of Tekla Structural Designer and Tekla Structures it is 

important to understand that the information transferred is essentially the physical 

information associated with the structure - e.g., geometry, section sizes and grade, number 

of studs and slab thicknesses etc. 

 

Tekla Structures allows engineers to quickly and easily create accurate structural models 

complete with information that offer value from design to construction completion. Design 

data can be imported and enhanced with Tekla Structures to produce complete, coordinated 

and constructible drawings and material lists. 

 

The integration process allows users to pass models to and from Tekla Structural Designer 

and Tekla Structures, updating changes to the physical model whilst also allowing both 

parties to concurrently update their own versions of the model. As the model is integrated 

between software applications, the user will find that changes are updated whilst additional 

items created since the last export operation are maintained within the model. 
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2.0 Project Workflows 

Integration between Tekla Structural Designer and Tekla Structures has been developed to 

ensure the initial model can be started in either tool without any detriment to the design 

process. This added flexibility enables companies to align their software solutions closely to 

their own workflows. (i.e., The initial model can be created in Tekla Structural Designer by 

the Engineer, or in Tekla Structures by the Technician.) 

 

We would recommend that the Tekla Structures model be used as the master model for all 

geometrical changes. Alterations made to the model geometry are best handled by altering 

the Tekla Structures model and transferring the changes through to Tekla Structural 

Designer for redesign. 

 

A typical workflow and the decision making process through the different stages of a project 

could be as follows:- 

 

2.1 Initial Scheme Stage  

● The initial model may be started in Tekla Structural Designer or Tekla Structures 

without any detriment to the process. 

● A number of factors may determine which software is used in the initial modeling 

process, such as availability of staff, or deliverable requirements. 

● Unless there are external drivers, Tekla Structures may prove to be the best starting 

point for the model as it can provide most of the deliverable items at the initial stage. 

● The model does not need to cover the complete building, it might be a typical bay or 

floor for example. 

● The generated structure can be designed in Tekla Structural Designer for initial 

section sizing at the initial stage and synchronized back to Tekla Structures for initial 

drawings or material list creation. 

● Simple drawings can be created at this stage; this can be done in Tekla Structural 

Designer or Tekla Structures. 

● Initial material lists for cost estimates can be generated at this stage. 
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2.2 Detailed Design 

● It is not always appropriate to carry models forward from the Initial Scheme Stage to 

the Detailed Design Stage. It is sometimes better to begin the model again. 

● Models can be started in Tekla Structures or Tekla Structural Designer to suit the 

user. The models can then be transferred to the other modeling system. 

● Importantly, the two models can be worked on at the same time, with synchronization 

of the two models taking place to suit the workflow. 

● Within Tekla Structural Designer, the model can be used for a full design of the 

structure, sway check, lateral (wind) design and a design of connections (if required). 

● Within Tekla Structures, drawings can be generated to a Tender stage level and 

general arrangements submitted to Building Control for approval. 

 

2.3 Construction Stage  

● Using the model from the Detailed Design stage, much of the Construction Stage 

process will take place in Tekla Structures so that the integration with other trades 

can be accounted for. 

● The design is not revisited unless the client drives the requirement for change. 

● If a re-design of the structure is required, the same synchronization of Tekla 

Structural Designer and Tekla Structures models can be carried out to suit the user. 

● The model will be completed within Tekla Structures and fully detailed drawings for 

parts can be created along with construction level drawings of the structure. 

● Detail integration checks with other trades (e.g. Mechanical and Electrical Engineers) 

can be carried out at this stage. 

 

2.4 Workflows for integration 

There are two specific integration workflows stipulated within this manual. These workflows 

differ depending whether the workflow is started within Tekla Structural Designer or Tekla 

Structures. 

● Starting in Tekla Structural Designer 

○ Allows full bi-directional model updates 

○ Requires additional parts to be generated from common intersection points 

● Starting in Tekla Structures 

○ Requires analysis and design model to be created prior to transfer 

○ Limited bi-directional model updates 
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2.5 Where to start? 

As mentioned above, there are specific workflows to consider depending on whether the 

initial model is created within Tekla Structural Designer or within Tekla Structures. 

 

● When starting in Tekla Structural Designer, the initial import into Tekla Structures 

sets all parts from common intersection points. This may mean that some parts such 

as slabs and bracing are not in the correct positions to begin the detailed design or 

construction phases. 

○ We would recommend that when starting the integration process from Tekla 

Structural Designer, the entire design and integration process is completed 

before advancing the model into either the detailed design or construction 

phases. 

 

● When starting in Tekla Structures, the model may be generated from positions more 

suitable for the detailed design or construction phases. The analysis and design 

model created within Tekla Structures can use these physical positions whilst 

generating an analytical model which is still analytically connected and won’t 

introduce eccentric analytical connections. 

○ The workflow however is limited when considering updates to existing parts 

and positional changes or offsets will not be considered when returning 

results from Tekla Structural Designer. 

○ In this case, the Tekla Structures model must act as the master model. 

Changes to positions are made in this model only and exported to Tekla 

Structural Designer for a full design of the structure. New parts, profile 

changes and material changes are then returned back to the Tekla Structures 

model. 

 

2.5.1 File format 

In addition to the information listed above, there are two separate file formats to be 

considered. 

● Model file format (.tsmd file) 

○ Requires both Tekla Structural Designer and Tekla Structures to be installed 

on the same machine. 

○ Allows the transfer of design intent rebar objects from Tekla Structural 

Designer 

○ Does not support the transfer of member end forces, web openings, cellular 

beam infills or opening stiffeners. 

● Neutral file format (.cxl file) 

○ Allows the transfer of member end forces 

○ Allows the transfer of web openings and stiffeners from Tekla Structural 

Designer into Tekla Structures. 

○ Allows the transfer of infill data and ring stiffeners for Westok cellular beams 

from Tekla Structural Designer into Tekla Structures. 

○ Does not support the transfer of design intent rebar objects from Tekla 

Structural Designer 
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3.0 Minimum versions for integration 

Please note that depending on the file format and the workflow to be used, there are some 

minimum version requirements to consider. 

3.1 Minimum version for neutral file transfer 

In order to use the neutral integration file format, you must be using at least Tekla Structures 

v21.0 or later. Integration will not be possible using any method if using a version of Tekla 

Structures earlier than v21.0. 

● If using v21.0 only, please note that an Integrator macro is required for installation. 

This can be found within the Tekla warehouse (http://warehouse.tekla.com). 

● From v21.1 onwards the integration commands were hardcoded into the software. 

 

3.2 Minimum version for model file transfer 

In order to use the model file transfer, you must be using Tekla Structures 2020 or later. This 

functionality is not available in earlier versions. 

 

3.3 Minimum version for Tekla Structures analysis model 

In order to use the analysis model commands within Tekla Structures to export a model to 

Tekla Structural Designer, you need to be using Tekla Structures 2018 or later. This 

functionality is not available in earlier versions. 

 

3.4 Minimum version for Rebar transfer 

To integrate design intent rebar content from Tekla Structural Designer to Tekla Structures, 

you will need to be using Tekla Structures 2020 or later. This functionality is not available in 

earlier versions. 

 

3.5 Does software need to be on the same computer? 

Please note that if you intend to use the model file integration method (including design 

intent rebar content), both Tekla Structural Designer and Tekla Structures must be installed 

and have licenses available for use at the time of integration. 

If you intend to use the neutral file method to integrate models it is not necessary to have 

both Tekla Structural Designer and Tekla Structures on the same computer. 

http://warehouse.tekla.com/
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4.0 Starting the workflow with Tekla Structural Designer 

4.1 Creation of the Tekla Structural Designer Model 

The Engineer has a number of options available to him when creating a Tekla Structural 

Designer model.  

 

4.1.1 Create model from Scratch 

● Tekla Structural Designer includes typical modeling tools to create grids, columns, 

beams, walls, floors etc. Importantly, each element is modeled as a physical object 

that can be positioned correctly in space.  

● When synchronized with Tekla Structures, the true spatial position is communicated 

along with items such as sections size, grade, studs, holes etc. 

4.1.2 Part Models 

● At the early stages of design, it is possible to create part models to investigate a 

structural scheme.  

● For example, the engineer can model just a floor or a bay in Tekla Structural 

Designer to investigate the best solution to satisfy code compliance and economics. 

● Although only a part model, this can still be sent to Tekla Structures. (Note, the 

physical position of the part model will be communicated to Tekla Structures.) 

● For example, if an engineer models a floor but the true level is not yet known, this 

part model can be sent to Tekla Structures where adjustments can be made. If this 

model is communicated back to Tekla Structural Designer, its position will be 

updated. 

● At the early design stages, it is reasonable to stop the bi-directional integration as 

new refined models are often created later in the design process. 

 

4.1.3 Import 2D Drawings 

● It is common early in a project to have a number of 2D architectural drawings 

outlining the scheme. Tekla Structural Designer has the facility to import 2D DXF 

drawings. 

● The engineer can use these drawings as ghost layouts in the background to aid 

setting out or to import grids. 

● If a common grid is used on the project, it is logical to import this grid into Tekla 

Structural Designer to ensure the structure is set out in the correct position. 

● If a number of separate models are to be created and merged together it is strongly 

advisable to use a common grid system. 

● When importing grids it is also advisable to check the geometry of the grid 

thoroughly.  
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4.2 Deliverables 

Even at these early stages of a project, Tekla Structural Designer provides a significant 

number of the deliverables required. 

For example:- 

● Comprehensive code compliant scheme design. 

● Material take-off.  

● 2D engineering DXF drawings. 

● Member end forces and support reactions. 

 

4.3 Do you need to create an export? 

When considering the transfer of information from Tekla Structural Designer to Tekla 

Structures, you may ask whether you need to export a neutral file from the software or 

whether to provide the model file to the Tekla Structures user? 

There are a number of factors which may mandate the use of either a neutral file or the use 

of the model file. 

 

● Do both Tekla Structural Designer and Tekla Structures reside on the same 

computer? 

○ If they don’t, then a .cxl format neutral file must be used for integration purposes. 

● Do you wish to transfer design intent rebar objects? 

○ If you do, then you must use a .tsmd model file for integration. 

● Do you wish to transfer member end forces from Tekla Structural Designer to Tekla 

Structures? 

○ If you do, then a .cxl format neutral file must be used for integration purposes. 

● Do you wish to transfer web openings and stiffeners from Tekla Structural Designer 

into Tekla Structures? 

○ If you do, then a .cxl format neutral file must be used for integration purposes. 

● Do you wish to transfer infill data and ring stiffeners for Westok cellular beams? 

○ If you do, then a .cxl format neutral file must be used for integration purposes.  
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4.3.1 Exporting a .cxl format neutral file from Tekla Structural Designer 

Once a model has been created in Tekla Structural Designer, you need to save the model 

with a recognizable name and then run the command Tekla Structures Export (BIM 

Integration tab). 

 

 
 

Running the command will start the export application with various dialogs displayed through 

a wizard process. 

 

The first screen encountered provides some information about the two base design products 

used with the Integrator. Click Next to move onto the next page. 
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The following screen will allow you to move the model to real world coordinates by 

entering suitable figures within the dialog. In our case, we will keep the values at the default 

and just choose Next. 

 

 
 

After the model location, you will be prompted to choose the element types to choose to 

export along with options for openings where applicable. The default settings are that all 

items should be exported. In this example, we will follow the same settings and export all 

object types – clicking Next to continue. 
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In this example, we have chosen to export Analysis Results as the model has been 

successfully analyzed and designed within Tekla Structural Designer. This option 

(deselected as default) directs us to a new dialog where we can choose which analysis 

methods, loadcase results and load combination results we can choose to export. We keep 

the default setting of first order linear analysis results for all combinations and simply click on 

the Next button to advance. 
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Mapping of materials to recognized grades will be then shown. Here you can view the 

different materials being used in the Tekla Structural Designer model and the option to 

overwrite the exported materials with a more preferred grade. 

 

 
 

Following on from Material mapping, the dialog for Decking mapping will be shown (if 

applicable). Again this allows users to view the decking types being used in the model and 

have the option of overwriting the exported details if required. 

 

 
 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  16 
 

The final dialog screen of the export wizard will prompt for a filename and location of the 

CXL file to be created. Please note that there are two options relating to a First Time Export 

and an option to Update Existing Model. 

For the initial export, the option First Time Export should be chosen. (The option to Update 

Existing Model will be used to pass alterations in the event of a Tekla Structures model 

already in existence.) 

 

4.3.2 BIM Integration command 

The BIM Status command (held under the Review tab) can be used to provide a color 

coded indication of how the model has been affected in the last import and also control the 

content of the integrated model. 
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By clicking on each member, wall and slab within the model it is possible to exclude the 

object from the integration process. Please note that clicking on the excluded object again 

will revert the status to the original coloring. 

 

A full list of the status is shown below, please note that some of the status entries are related 

to the synchronization stage and may not be relevant at this stage. 

 

Color coding Description 

 New 

Object has been created in Tekla Structural Designer and has not 

yet 

been exported to Tekla Structures. 

 Imported 

Object has been created by the import from Tekla Structures. 

 Exported1 

Object has been previously exported to Tekla Structures (prior to any 

import processes).1 

 Updated 

Member has been modified as a result of the Structural BIM import. 

Check the BIM Status tree for details. 

 Deleted 

Object has been deleted in Tekla Structures but has been retained 

during the merge process due to the Integration Filter settings. 

 Excluded 

Object will not be communicated from Tekla Structural Designer to 

Tekla Structures. 

 Not Modified 

Object has not been altered in any way by the Structural BIM Import 

process. 

 
1 The Exported status is only used in conjunction with .cxl format neutral files. If a model is 

imported from .tsmd model files then no object inside the Tekla Structural Designer model 

will be flagged as being Exported. 
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Please note that it is possible to change the exclusion status to all objects in the Tekla 

Structural Designer command by right-clicking and using the Toggle BIM status command. 
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4.4 Importing a model into Tekla Structures using .tsmd model 

files 

This example covers the import of a model into Tekla Structures using a .tsmd format model 

file. The file that we are using contains no mapping problems (section sizes not being 

automatically recognized by the integration process) and reference should be made to 

Section 6 - Managing the conversion process if you find that your own files do contain 

problems regarding unrecognized sections.  

 

This example is going to follow a first time import into Tekla Structures from Tekla Structural 

Designer so initially we start with a new Tekla Structures model. 
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To import a model we need to use the command Import - Tekla Structural Designer which 

is available from the software File menu. 
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When the Import From Tekla Structural Designer command dialog appears, the first step 

should be to select the .tsmd file to be imported into the model. This can be done by clicking 

on the … button to the top right and browsing to the file with a simple windows dialog. 
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There are a number of options held in the Import dialog which may be considered during the 

integration process.  

 

● Only consider profile and material changes 

○ This option is used when importing updated models into an existing model. As 

it suggests, it will ignore all positional modifications made as part of the 

update process. 

● Import project properties from import file 

○ This option populates the Tekla Structures Project Properties dialog (File → 

Project Properties) with the contents of the Tekla Structural Designer 

Project Wiki command (Home tab). 

● Import grids from import file 

○ This option will import the grid pattern defined within the Tekla Structural 

Designer neutral file. 

● Delete existing Tekla Structures grids 

○ This option will delete all grid objects from the Tekla Structures model prior to 

performing the import process. 

● Remove previously imported openings 

○ This option will remove all openings created from previous import processes. 

It will not affect any openings created as part of the modeling process within 

Tekla Structures. 

 

● Location 

○ Offset X 

■ This setting will offset the contents held in the .tsmd model file by the 

value entered. Please note that negative values are allowed. 

○ Offset Y 

■ This setting will offset the contents held in the .tsmd model file by the 

value entered. Please note that negative values are allowed. 

○ Offset Z 

■ This setting will offset the contents held in the .tsmd model file by the 

value entered. Please note that negative values are allowed. 

○ Pick 

■ This option will allow a position to be chosen within the model which 

will automatically update the Offset X, Offset Y and Offset Z values to 

suit. 

○ Rotation 

■ This setting will apply a rotation to the model as a whole when 

imported into Tekla Structures. The values entered are given relative 

to the model imported origin, with positive values being taken counter-

clockwise and negative as clockwise. 
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Once the file has been selected, the next stage should be to check the mapping of members 

between the software packages. This stage is covered in depth during Section 6 - 

Managing the Conversion Process. 
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Towards the bottom of the dialog is a final option for Show model comparison tool. This 

option is ideally used when importing updated models into an existing model. This option 

allows for updates to be checked and controlled and will be covered in detail within section 

4.8.3. 

For this example, we will uncheck the option and then click on the Import button to start the 

processing of the .tsmd model file. 

 

 
 

The processing stage will then commence and display the statistics of the import process. 
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The statistics show the processes performed and the part types which have been Added. 

Please note that there should be no entries for Updated, Deleted or Unchanged as this 

was not an update process into an existing Tekla Structures model. 

 

Following on from this, the import has been completed and the Tekla Structural Designer 

Import dialog may be closed. 

 

4.4.1 Minimum version and license requirements 

Please note that in order to use the .tsmd model integration process, both Tekla Structural 

Designer and Tekla Structures must be both installed and licensed on the same machine. 

A minimum of Tekla Structures 2020 and Tekla Structural Designer 2020 needs to be 

installed to use the .tsmd model integration process. 

Please note that the yearly version numbers should be identical to ensure successful model 

integration. e.g. Tekla Structural Designer 2022 should be installed alongside Tekla 

Structures 2022 or Tekla Structural Designer 2023 should be installed alongside Tekla 

Structures 2023. 

● NB: This rule may be relaxed in future versions of both the Tekla Structural Designer 

and Tekla Structures software, please check with your local customer service team if 

any questions arise. 

 

4.4.2 Rebar 

A benefit of the .tsmd model integration process is the ability to import design intent rebar 

objects. These will be imported for all designed reinforced concrete column, beam, slab or 

panel parts. 

Please note that rebar objects will only be created for rectangular concrete columns and 

beam members. No rebar will be created for any non-rectangular column or beam parts. 

Please note that no rebar objects will be created for any precast concrete column or beam 

parts irrespective of the profile shape. 
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4.4.2.1 Loose bar reinforcement 

When considering design intent rebar for slabs and panels, please note that only loose bar 

reinforcement will be created. No mesh reinforcement will be generated as part of the import 

process. 

 

Options to use loose reinforcement can be set on each wall and slab object with Tekla 

Structural Designer. This option can be found under the Reinforcement heading in the 

Properties dialog. 

 

 
● Reinforcement option within Wall Properties 
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● Reinforcement option within Slab properties 
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Further options to create loose reinforcement rather than mesh reinforcement within Tekla 

Structural Designer are held within the Settings command on the Design tab. 

 

 
• Option for loose bars within Wall objects - this option affects panel parts within Tekla Structures. 

 

 
• Option for loose bars within Slab objects. 
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4.4.4.2 Reinforcement import options within Tekla Structures 

There are a number of options available within Tekla Structures which affect the integration 

of design intent rebar objects. 
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● Rebars 

○ Import rebars (Enabled as default) 

■ This option controls the import of rebar objects. If it is enabled, then 

design intent rebar will be created as part of the integration process. 

○ Delete old rebars (Enabled as default) 

■ If this option is enabled, any rebar previously created by the import 

process will be deleted as part of the integration process. Please note 

that this option will have no effect on rebar created manually outside 

of the integration process. 

● Create rebars as 

○ Native bars (Enabled as default) 

■ Design intent rebar will be created as native bar objects using Tekla 

Structures rebar set technology. If the option is disabled, no rebar 

content will be created as native bars. 

○ Reference bars 

■ All design intent rebar will be created as a single reference model. 

This can then be used to trace model rebar objects if required. The 

reference model can be disabled or deleted using standard Tekla 

Structures commands. 

● Creation options 

○ Once per design group 

■ Only one set of rebar will be created for each part in each design 

group. This option allows the detailer to modify and complete the 

detailing process before copying the rebar sets around other members 

held in the same design group. 

○ Simplify bars 

■ This option controls the import of information linked to end detail 

modifiers (hooks) and splitters (laps and cranks). If it is enabled then 

no end detail modifiers or splitter information will be enabled. 

● Import rebars for 

○ Beams (Enabled as default) 

■ If enabled, design intent rebar will be created for beam parts. If 

disabled, no rebar will be created as part of the import process. 

○ Columns (Enabled as default) 

■ If enabled, design intent rebar will be created for column parts. If 

disabled, no rebar will be created as part of the import process. 

○ Walls (Enabled as default) 

■ If enabled, design intent rebar will be created for wall parts. If 

disabled, no rebar will be created as part of the import process. 

○ Slabs (Enabled as default) 

■ If enabled, design intent rebar will be created for slab parts. If 

disabled, no rebar will be created as part of the import process. 
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○ Foundations (Enabled as default) 

■ If enabled, design intent rebar will be created for foundation parts. If 

disabled, no rebar will be created as part of the import process. 

Please note that only rectangular pad bases and strip base wall 

objects within Tekla Structural Designer will be considered for rebar 

creation. 

 

4.4.4.3 Using design intent rebar after the import process 

● As mentioned above, design intent rebar is created using Tekla Structures rebar set 

technology. This allows rebar to be manipulated and adjusted easily after the initial 

rebar creation process has been completed. 

● Please note that main bars will be created from the bottom of the lowest column 

stack, extending 1000mm less cover settings (e.g. 965mm for 35mm cover) below 

the column. This allows the rebar detailer to manipulate the rebar sets and any 

assigned end detail modifiers to suit the finalized detail requirements. 

● Rebar sets are created from the Import into Tekla Structures, they cannot be 

exported back into Tekla Structural Designer. Any changes to rebar sizes or centers 

should be made to the Tekla Structural Designer model and then reimported into the 

Tekla Structures BIM model. 
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4.5 Importing a model into Tekla Structures using .cxl neutral 

files 

This example covers the import of a model into Tekla Structures. The file that we are using 

contains no mapping problems (section sizes not being automatically recognized by the 

integration process) and reference should be made to Section 6 - Managing the 

Conversion Process if you find that your own files do contain problems regarding 

unrecognized sections.  

 

This example is going to follow a first time import into Tekla Structures from Tekla Structural 

Designer so initially we start with a new Tekla Structures model. 
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To import a model we need to use the command Import - Tekla Structural Designer which 

is available from the software File menu. 
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When the Tekla Structural Designer Import command dialog appears, the first step should 

be to select the .cxl format neutral file to be imported into the model. This can be done by 

clicking on the … button to the top right and browsing to the file with a simple windows 

dialog. 
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Please note that when selecting the file to be imported, the default file format is set to be a 

.tsmd model file. This filter needs to be changed to use the Tekla Structural Designer XML 

file format (.cxl) in order to select the previously exported file. 

 

 
 

There are a number of options held in the Import dialog which may be considered during the 

integration process.  

 

● Only consider profile and material changes 

○ This option is used when importing updated models into an existing model. As 

it suggests, it will ignore all positional modifications made as part of the 

update process. 

● Import project properties from import file 

○ This option populates the Tekla Structures Project Properties dialog (File → 

Project Properties) with the contents of the Tekla Structural Designer 

Project Wiki command (Home tab). 

● Import grids from import file 

○ This option will import the grid pattern defined within the Tekla Structural 

Designer neutral file. 

● Delete existing Tekla Structures grids 

○ This option will delete all grid objects from the Tekla Structures model prior to 

performing the import process. 

● Remove previously imported openings 

○ This option will remove all openings created from previous import processes. 

It will not affect any openings created as part of the modeling process within 

Tekla Structures. 

 

● Location 

○ Offset X 

■ This setting will offset the contents held in the .cxl neutral file by the 

value entered. Please note that negative values are allowed. 

○ Offset Y 

■ This setting will offset the contents held in the .cxl neutral file by the 

value entered. Please note that negative values are allowed. 

○ Offset Z 

■ This setting will offset the contents held in the .cxl neutral file by the 

value entered. Please note that negative values are allowed. 
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○ Pick 

■ This option will allow a position to be chosen within the model which 

will automatically update the Offset X, Offset Y and Offset Z values to 

suit. 

○ Rotation 

■ This setting will apply a rotation to the model as a whole when 

imported into Tekla Structures. The values entered are given relative 

to the model imported origin, with positive values being taken counter-

clockwise and negative as clockwise. 
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Once the file has been selected, the next stage should be to check the mapping of members 

between the software packages. This stage is covered in depth during Section 6 - 

Managing the Conversion Process. 

 

Towards the bottom of the dialog is a final option for Show model comparison tool. This 

option is ideally used when importing updated models into an existing model. This option 

allows for updates to be checked and controlled and will be covered in detail within Section 

4.8 - Subsequent transfer from TSD into TS. 

For this example, we will uncheck the option and then click on the Import button to start the 

processing of the .cxl neutral file. 

 

 
 

The processing stage will then commence and display the statistics of the import process. 
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The statistics show the processes performed and the part types which have been Added. 

Please note that there should be no entries for Updated, Deleted or Unchanged as this 

was not an update process into an existing Tekla Structures model. 

 

Following on from this, the import has been completed and the Tekla Structural Designer 

Import dialog may be closed. 

 

4.5.1 Viewing member end forces 

Following on from a successful import process, the member end forces can be viewed. This 

can be done either by using the Inquire Part command or accessing the User-defined 

attributes → End conditions dialog through Model Object Properties. 

 

A full list of the member end forces imported into Tekla Structures from Tekla Structural 

Designer can be found in Appendix 3. 

 

 
• member end forces shown when using the Inquire Part command. 
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• member end forces shown within the End conditions dialog. 
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4.5.2 Concrete parts and designed rebar 

The import of physical rebar objects is not supported by the .cxl neutral file format. In order 

to import the rebar design intent as physical objects the .tsmd model file import must be 

used. 

Please note that attributes showing the design intent are still available when using the .cxl 

neutral file format, these can be viewed directly by using the Inquire Part command. 

For a full list of imported attributes, please refer to Appendix 3. 

 

 
• Rebar attributes shown using the Inquire Part command. 
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4.6 After import 

After the import process has been completed, you may wish to investigate the created model 

and parts further. This section provides information relating to the different part and object 

types created by the Import from Tekla Structural Designer process. 

4.6.1 Created objects 

4.6.1.1 Grids 

Construction Lines 

Please be aware that there is a clear difference between Grid objects and Construction 

Line objects within the Tekla Structural Designer software :- 

Construction Lines are view specific objects and only appear on the view that they were 

created in. 

Construction Lines will not be exported to Tekla Structures. 

 

Grids 

Grids are imported from Tekla Structural Designer as individual lines held within the single 

grid object and can be physically manipulated after import. When considering grid line 

names within Tekla Structural Designer, please note that there are no realistic limitations for 

individual grid names. However please note that only latin alphanumeric characters are 

transferred by the integration process. 

 

 
 

 Care should be taken when viewing the grid properties. The Coordinates - X and 

Coordinates - Y entries will only show the extent of the pattern but no detailed grid line 

information. 

Similarly, the Labels - X and Labels - Y entries will not show any meaningful information 

related to the grid. 
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All grid information from Tekla Structural Designer will be imported into Tekla Structures 

using 

identical element definition points. As the amount of grids used in the Tekla Structural 

Designer model may not meet the requirements of the Tekla Structures user, extraneous 

grids may be removed or new entries added to suit their own needs. 

 

Please note that only linear grids can be integrated, curved grids are omitted from the 

integration process. 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  43 
 

4.6.1.2 Construction levels 

Levels are transferred from Tekla Structural Designer with data being entered into the Grid 

dialog. Labels - Z are populated from the Name entry held in the Construction Levels 

dialog and Coordinates - Z are created from the Level entry. 

 

 
 

 

Please note that only Z-entries containing a part handle or the end of an analytical bar will be 

considered for export back to Tekla Structural Designer. 
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4.6.1.2.1 Floor Setting 

When generating levels within Tekla Structural Designer, it is important to understand that 

not all levels need to be transferred using the Integrator. 

For levels generated in Tekla Structural Designer, only levels that have been flagged as 

Floor items will be exported. The exception to this rule is the lowest most entry in the dialog, 

which is ALWAYS exported, regardless of the Floor flag setting. 

e.g. When looking at the example below, we find that four levels would be exported. Three 

of the levels are flagged as Floor whilst the lowest most level is always exported. 

 

 
 

4.6.1.2.2 Level Type 

Level entities in Tekla Structural Designer can be defined as Structural Slab Level (S.S.L.), 

Top of Foundations (T.O.F.) or Top of Steel (T.O.S.). Concerning the integration process 

with Tekla Structures, this affects the vertical slab location. 

Where levels are defined as Top of Steel, the slab will be offset equal to its depth so that 

the underside of the slab is located in line with the level entity. 

Where levels are defined as either Structural Slab Level or Top of Foundations, the slab 

will not be offset. The top of the slab will be in line with the level entity. 
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4.6.1.2.3 Level Source 

Tekla Structural Designer can use the concept of source levels to duplicate the content and 

simplify the modeling process. It is important to note that Revit has no concept of duplicate 

floors within the software, therefore duplicate levels are imported into Revit as independent 

unique levels. 

If this model is then returned from Revit to Tekla Structural Designer, the source/duplication 

settings are reset during the merge process and all levels are flagged as unique. 

No items will be physically lost as part of this change and the flag can be reapplied if 

necessary. 
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4.6.1.3 Parts 

Parts will be generated inside Tekla Structures to suit all content exported from Tekla 

Structural Designer. Parts will be created with part handles set to suit the overall analysis 

wire position set within Tekla Structural Designer. 

 

 
 

4.6.1.3.1 Offsets 

End offsets are transferred from Tekla Structural Designer to Tekla Structures and vice-

versa. (Global End-Offset settings within Tekla Structural Designer). These settings can be 

used to integrate positional settings. 

 

 
  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  47 
 

4.6.1.4 Slabs 

Slab objects are integrated in both directions between Tekla Structural Designer and Tekla 

Structures. Please note that the slab analysis wire is defined by the boundary outline, this 

means that the slab will not cover the full flange extent after transfer into Tekla Structures. 
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4.6.1.4.1 Outlines 

When transferring slab parts from Tekla Structures to Tekla Structural Designer, please note 

that the resulting slab in Tekla Structural Designer will be created based on the physical 

outline within Tekla Structures. 

Depending on the slab type being analyzed, this may lead to the slab being flagged as 

analytically unsupported within Tekla Structural Designer. 

 

 
 

If intending to integrate slabs from Tekla Structures to Tekla Structural Designer please 

create slab parts from common intersection points such as centers of supporting beam and 

column parts. 

If this is not possible, please consider not integrating the slab parts and building these 

elements from scratch within Tekla Structural Designer. These same new slabs can then be 

omitted from the Structural BIM transfer process by using the BIM Status command. 
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4.6.1.4.2 Openings 

Rectangular and circular openings in slabs are imported from Tekla Structural Designer to 

Tekla Structures. 

 

 
 

Openings modeled in Tekla Structures will only be exported when using the Export to Tekla 

Structural Designer with analysis model command. 

If using the command Export to Tekla Structural Designer, no opening information will be 

included. 
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4.6.1.5 Walls 

Bearing wall, Shear Only wall and General Wall objects are integrated between Tekla 

Structural Designer and Tekla Structures. These panel parts will also be returned from Tekla 

Structures into Tekla Structural Designer. 
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4.6.1.5.1 Openings 

It should be noted that some wall openings cannot be created within Tekla Structural 

Designer. If wall openings are created within Bearing wall and Shear Only wall objects 

within Tekla Structural Designer, the boundary will be shown but no opening will be created. 

 

 
 

When these walls are integrated into Tekla Structures, the openings for these walls are 

successfully created. 

 

 
Openings modeled in Tekla Structures will only be exported when using the Export to Tekla 

Structural Designer with analysis model command. 

If using the command Export to Tekla Structural Designer, no opening information will be 

included. 
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If holes are exported from Tekla Structures for Bearing walls or Shear Only walls, no actual 

opening will be created within Tekla Structural Designer, instead the opening shape will be 

imported as a sketched outline only. 
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4.6.1.6 SJI Joists 

US region SJI Joists are integrated between Tekla Structural Designer and Tekla Structures 

in both directions. Please note though that Tekla Structures uses an alternative physical 

representation for the joists than Tekla Structural Designer 

Please note that Tekla Structures doesn’t contain the same range of sections in the part 

catalog as Tekla Structural Designer. Reference should be made to Section 6 - Managing 

the conversion process. 

 

 
 

Changes to the visual representation of the joists within Tekla Structures can be made using 

components. 
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4.6.1.7 Plate Girder, Fabsec and Westok Plated Beams 

Plate Girder objects, Fabsec beams and Westok Plated Beams are all integrated between 

Tekla Structural Designer and Tekla Structures. Mapping for these objects is automated so 

no manual conversion is required. 

 
 

4.6.1.8 Web openings and stiffeners 

Web openings are imported from Tekla Structural Designer along with any associated 

stiffeners when using .cxl format neutral files. No web openings or stiffeners will be imported 

when using .tsmd format model files to perform integration. 

 

 
 

No web openings or stiffeners are exported from Tekla Structures to Tekla Structural 

Designer.  
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4.6.1.9 Westok cellular beams 

Westok cellular beams are imported into Tekla Structures from Tekla Structural Designer.  

Profile information for Westok cellular beams is not exported from Tekla Structures to Tekla 

Structural Designer though. If Westok cellular beams are integrated from Tekla Structures to 

Tekla Structural Designer, one of two outcomes will arise :  

● If no existing Westok is present in Tekla Structural Designer, Analysis elements will 

be created. 

● If an existing Westok cellular beam is present in Tekla Structural Designer, no 

changes to the section will occur and the original beam will remain unaffected by the 

update process. 

 

 
 

If the integration between Tekla Structural Designer to Tekla Structures has been performed 

using .cxl format neutral files, infill data and ring stiffener information will also be transferred 

into the Tekla Structures model. Stiffeners for elongated openings are omitted however. 

 

If integration between Tekla Structural Designer to Tekla Structures has been performed 

using .tsmd model files, no infill or stiffener data will be transferred. 

 

4.6.2 Parameters created  

After importing models into Tekla Structures from Tekla Structural Designer, parameters 

relating to the design will be created on each part. These parameters can be included in 

drawing labels, the organizer and in any generated lists. 

Parameters are created for all beam, column, bracing, slab and wall parts, with additional 

parameters included for member end forces and reinforced concrete parts. 

 

● For a full range of the parameters populated during the integration process, please 

refer to Appendix 3 at the end of this document. 
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4.6.3 Build parts from common intersection points 

The import from Tekla Structural Designer creates parts with the part handle location set to 

suit the insertion points used in the Tekla Structural Designer model. 

This means that all parts in the created Tekla Structures model will intersect at common 

insertion points such as centers of columns or grid intersections. 

 

 
 

In order to export an analytically connected model back to Tekla Structural Designer from 

Tekla Structures, any additional parts should be modeled from similar locations. These may 

be centers of supporting columns, centers of supporting beams or grid intersections. 

 

If parts are not modeled from these common intersection points, there is a risk that the part 

will be analytically unconnected after transfer into Tekla Structural Designer. This will require 

manual adjustment before any analysis or design procedure can be attempted. 

 

Please note that this rule applies to exports performed using the Export to Tekla Structural 

Designer command only. Integration processes created using the Export to Tekla 

Structural Designer with analysis model command use a different procedure to ensure 

analytical model connectivity. Please refer to Section 5 - Starting the workflow with Tekla 

Structures for further details. 
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4.6.3.1 Move parts or Offset parts? 

With regards to parts created in Tekla Structures, please note that there is a difference 

between moving a part and applying an offset to a part. 

● Moving a part will move the part handles as well as the physical representation. This 

may mean that the part moved is no longer analytically supported after transfer to 

Tekla Structural Designer. 

● Applying an offset to a part will adjust the location of the physical representation, but 

will keep the grip handles in the original position. This is the recommended method of 

adjusting the physical representation but ensuring analytical connectivity. 
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4.6.4 Components 

After completing the import process into Tekla Structures from Tekla Structural Designer, 

you may want to complete the detailed design stage and move into the construction phase of 

the project. 

In order to do this, you can add components creating the end connections, or amend any 

imported rebar to be more constructible. 

This can be done after the entire process of updating the model with amendments from the 

Structural Engineer has been completed. 

 

 
 

It is possible to add components as the integration processes with the structural engineer 

are ongoing, but please ensure that all connections are excluded from any individual export 

process. See the following note for further details. 
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4.6.4.1 Should you detail when design is ongoing? 

Please note that any export processes performed from Tekla Structures are based on 

selected parts, potentially including connections and other ancillary items which cannot be 

designed in Tekla Structural Designer. 

 

 
 

We would recommend the use of Object Group - View Filters to control the visibility of 

components and any manually created connections. Disabling the visibility of these items 

and then performing a selective export of the remaining visible parts should ensure a correct 

model is exported to Tekla Structural Designer. 

We would recommend that the Initial Scheme Stage and Detailed (Analytical) Design 

stages are completed and the Tekla Structures model is updated with the finalized profile 

layout and sizes before any sort of detail is applied to the model. 
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4.7 Returning information from Tekla Structures to Tekla 

Structural Designer 

4.7.1 Members created in Tekla Structures since the initial import 

 

 
 

In order to export an analytically connected model back to Tekla Structural Designer from 

Tekla Structures, any additional parts should be modeled from common intersection points. 

These may be centers of supporting columns, centers of supporting beams or grid 

intersections. 

 

If parts are not modeled from these common intersection points, there is a risk that the part 

will be analytically unconnected after transfer into Tekla Structural Designer. This will require 

manual adjustment before any analysis or design procedure can be attempted. 

 

Please note that this rule applies to exports performed using the Export to Tekla Structural 

Designer command only. Integration processes created using the Export to Tekla 

Structural Designer with analysis model command use a different procedure to ensure 

analytical model connectivity. 
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4.7.1.1 Ensuring connectivity 

When using the Export to Tekla Structural Designer command to integrate models back to 

Tekla Structural Designer, it can be difficult to verify the connectivity status of parts created 

in Tekla Structures. 

We would recommend that common intersection points are used as the basis of the 

modeling process, however there may be times when this is not possible. 

 

 
 

The Validate command held in Tekla Structural Designer is an essential tool when checking 

model connectivity and that valid models are being used for the analysis and design of 

structures. Using this command to check the structural integrity of the integrated model, 

unconnected members can then be manually corrected within Tekla Structures or Tekla 

Structural Designer. 
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4.7.1.2 Specifying object type 

Parts inside Tekla Structures can be identified as specific object types within Tekla Structural 

Designer, avoiding alteration and editing after integration with Tekla Structural Designer. 

To set the object type, edit the User defined attributes for any selected part and access the 

tab Tekla Structural Designer. The entries of TSD Member Type, TSD Slab Type and 

TSD Wall Type can then be set to suit the desired value. 

For a full list of object types, please refer to Appendix 4 at the end of this document. 

 

 
 

4.7.2 What are you exporting? 

The default settings when integrating using the Export to Tekla Structural Designer 

command are to export Selected Model objects. The alternative option available is to export 

All Model objects. 

 
 

Please note that when using the option for All Model objects during the export process, this 

will include connections and other ancillary items which cannot be designed in Tekla 

Structural Designer. 

 

If your model contains these items, we would recommend the use of Object Group - View 

Filters to control the visibility of components and any manually created connections. 

Disabling the visibility of these items and then performing a selective export of the remaining 

visible parts should ensure a correct model is exported to Tekla Structural Designer. 
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4.7.2.1 What file to create? .tsmd model file or .cxl neutral file? 

When specifying the file name, the choice of file extension can be chosen as either a .cxl 

format neutral file or as a .tsmd format model file. 

 

 
 

With regards to the functionality of the integration, there is no real difference between the 

two file formats during the integration process between Tekla Structures and Tekla Structural 

Designer. If you do not have Tekla Structural Designer licensed on the same machine as 

Tekla Structures, you should choose the .cxl format neutral file option. 
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4.7.3 Performing the export 

Having set the export filename and extension type (1), the Model objects option can be 

flagged (2). 

The next stage is to check the profile conversion and material conversion (3), see Section 6 

- Managing the conversion process for further details on how this is done. 

Click on the Export button (4) and the export process has been completed. 

 

 
 

If a .tsmd model file has been created then Tekla Structural Designer will now open and the 

import process will begin. If a .cxl format neutral file has been created, you can close down 

the Export to Tekla Structural Designer dialog and provide the created .cxl file to the 

engineer running Tekla Structural Designer. 
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4.7.4 Import into Tekla Structural Designer (No existing model) 

This section covers how to import a model into Tekla Structural Designer from Tekla 

Structures, if no existing model is open. If you intend to import changes into an existing 

Tekla Structural Designer model, please refer to section 5.4. 

The import method does differ if using a .cxl format neutral file or a .tsmd format model file, 

but only during the initial import phase. This will be described below. 

4.7.4.1 Initial import process using .cxl format neutral files 

When using .cxl format neutral files exported from Tekla Structures, the first stage should be 

to create a new model and then launch the Structural BIM Import command (held on the BIM 

Integration tab). 
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This then launches the BIM Integration wizard as shown below :  

The opening screen of the wizard prompts for the filename to be selected.  

 

 
 

Click on the … button to select the file to import. The Product Name and Version will then 

be populated along with any Project details. The Next button should then become available 

after the file has been selected, click on this button to continue. 

 

 
 

The following stage covers the initial import process using .tsmd model files, please skip this 

section if it’s not relevant and continue with section 4.7.4.3. 
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4.7.4.2 Initial import process using .tsmd format model files 

After performing the export using .tsmd format model files, the first stage performed is to 

create a .cxl format neutral file automatically. This is done by creating a file in the windows 

temporary directory with a similar name to the chosen export but containing a date and time 

stamp suffix. 

The process will then open a session of Tekla Structural Designer and the Structural BIM 

Import command will be run in the background. 

 

 
 

The created .cxl file will then be selected and the details populated within the dialog. Click 

Next to continue onto the next screen. 

 

The next screen of the wizard provides options for the Operation and the Settings used 

during the import process. 
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4.7.4.3 Import Options 

 
 

● Operation 

○ First Time Import 

■ Used when no Tekla Structural Designer model currently exists. 

○ Update Existing Model 

■ Used when importing changes made in Tekla Structures back into an 

existing Tekla Structural Designer model 

● Settings 

○ Unit System 

■ For First Time Import routines, it allows you to specify whether the 

Unit System for the created model will be US Customary units (feet 

and inches) or Metric. 

○ Regional Code 

■ This sets the regional design codes which are going to be used for the 

created model. 

○ Default Level Type 

■ This sets all newly created levels Type to be Top of Foundations 

(T.O.F.), Top of Steel (T.O.S.) or Structural Slab Level (S.S.L.) 

 

Please note that the Unit System and Regional Code settings are defaulted to suit the 

Model Settings of the Tekla Structural Designer file. 

In this example, we can keep all of the values at their default setting and click Next to 

continue. 
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4.7.4.4 Relocate Import Model 

This dialog allows models generated at real world coordinates (by using the Base Points 

command within Tekla Structures) to be relocated to the X : 0, Y : 0, Z : 0 location. 

It is important to have models located as close to the 0,0,0 location within Tekla Structural 

Designer to avoid rounding errors being introduced during any subsequent model analysis 

phase. 

The range of imported coordinates on the right of the dialog will give an indication of the 

coordinates used within the incoming file. If these are excessive (i.e. over 30,000 ft 

(10,000m) in any direction), please refer to the Tekla Structures user to determine the values 

used within the Base Points command. 

When relocating, please place in the inverse values in the Move import model by dialog. 

E.g. A model located at East coordinate 50000’ and North coordinate 40000’ would have 

entries of X : -50000’ and Y : -40000’. 

 

 
 

In our example, our model is already close to the 0,0,0 coordinates and doesn’t require 

relocation. We can click Next to continue. 
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4.7.4.5 Integration Filter 

The Integration Filter dialog allows control over the various object types in the incoming 

model. When performing an initial import process, only two options are available :  

● Include 

○ This toggles whether the type of items will be imported (checkbox enabled) or 

omitted from the import (checkbox disabled). 

● Include Openings 

○ This option controls whether openings modeled within object types are 

imported (checkbox enabled) or omitted from the import process (checkbox 

omitted). 

The four columns which are grayed are used for update processes and are not relevant at 

this stage. 

Please note that this command is an universal command affecting all software imports and 

not just Tekla Structures. Some of the options are not relevant to Tekla Structures, such as 

member openings. 
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4.7.4.6 Mapping and completing the import. 

The final stages of the import process is to check the mapping of Material Grades and 

Decking. The dialogs can be checked to ensure that valid grades and profiles are set before 

clicking on the Finish button to commence the import. 

 

 
 

4.7.4.7 The created model and validation. 

After completing the Structural BIM Import, the model will be shown… 
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…and the Structural BIM Import branch within the Status Tree will show the status of the 

overall process. 

 

 
 

Following on from a successful import process, the next stage should be to Validate the 

model. This command will pick up on any problems with connectivity, overlapping objects, 

duplicate objects and general analytical integrity. 

Successful validation is essential to perform an accurate design of the model at a later 

stage. 
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4.7.5 Subsequent import processes into Tekla Structural Designer 

Additional import processes into Tekla Structural Designer from Tekla Structures are virtually 

identical to the initial import process. 

The only differences during the process are firstly on the Import Options dialog. 

 

 
 

The Operation should now default to Update Existing Model. The additional change is that 

the Settings for Unit System and Regional Code are now grayed out as these have 

already been assigned during the initial import process.  

 

The second change during the process is that the Integration Filter now has all columns 

available. 
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The options shown here allow you to verify if grids, levels etc. are to be imported. 

You should also determine whether the five additional options are appropriate to the 

synchronization that you are performing. All of the options in this dialog can be described as 

follows : 

● Include (enabled as default) 

○ Simply controls whether objects of this type are considered by the Import, 

(added, modified or deleted if checked) or left as currently defined in the 

existing model, (not checked). 

● Delete Existing if not in Import File (enabled as default) 

○ If enabled, then an object in the existing model that is not in the import file 

(most likely already deleted in Tekla Structures) will be deleted from the Tekla 

Structural Designer model. 

■ If you are unsure and wish to double check, uncheck the box and you 

will find the member retained for manual deletion at a later date. 

■ There are exceptions, depending on the object’s BIM Status. If the 

status is New or Excluded, then the object will not be deleted during 

the update process whether this option is checked or not. 

● This option affects models created in Tekla Structures from 

.tsmd model files as the BIM Status is not changed to 

Exported as no actual export takes place within Tekla 

Structural Designer. 

● Grids 

○ Update Position affects the start and / or end of a grid line. Update Other 

Data affects changes made to the grid name only. 
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● Levels (Construction Level) 

○ Update Position affects any changes made to the level height within Tekla 

Structures. 

○ Update Other Data changes the name of the level to suit the Tekla 

Structures model. 

● Slabs / Deck (Slab Items) 

○ Update Section / Grade updates any alterations made to Slab Depth, 

Concrete Grade or Decking Properties (if relevant). 

○ Update Position makes changes to the outline of the slab, alignment (vertical 

offset) and plan rotation. 

○ Update Openings adds, removes or modifies the outline for openings 

associated with the slab item. See section 4.6.1.4.2 for restrictions 

○ Update Other Data will alter the type of slab if amended in Tekla Structures. 

● Members (Columns, Beams, Braces etc.) 

○ Update Section / Grade will update and changes made to the section size or 

the material grade. 

○ Update Position changes the member to suit alterations made to the start 

and / or end of the physical member, alignment or rotation in section. 

○ Update Openings adds, removes or modifies the outline for openings 

associated with the member. 

○ Update Other Data will change any other characteristics such as the gravity 

only flag and end release conditions. 

● Walls (Concrete and Bearing) 

○ Update Section / Grade controls any updates to the wall thickness and 

material grade. 

○ Update Position changes the wall to suit amendments made to the start and 

/ or end of the physical wall along with changes made to the alignment. 

○ Update Openings adds, removes or modifies the outline for openings 

associated with the wall. 

○ Update Other Data affects the Use mid pier option (Note: for concrete walls 

only) 
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4.7.6 Integration management in Tekla Structural Designer 

Once the synchronization process has been completed, the command BIM Status (held 

under the Review tab) can be used to provide a color coded indication of how the model has 

been affected in the last import. 

This view identifies all the changes to Tekla Structural Designer members and slabs which 

have occurred as a result of the merge process. 
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Once the synchronization process has been completed, the Structural BIM Import status 

tree (held under the Status tab) will show all newly created items or modifications performed 

by the merge process. These alterations to the model can be identified by double clicking on 

each entry in turn. This will highlight the affected member/object within the main Structure 

3D view. 

This status list can then be used to track alterations made to the model in the last import 

process 
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4.8 Subsequent transfer from TSD into TS 

4.8.1 Export process 

When performing subsequent integration processes from Tekla Structural Designer to Tekla 

Structures, the process is virtually identical to the initial export process. The only difference 

is when creating a .cxl format neutral file using the Export to Tekla Structures command, 

the Operation should be flagged as Update Existing Model (Neutral File Export File 

screen). 

 

 

4.8.2 Importing an updated model into Tekla Structures 

To update existing Tekla Structures with amendments from Tekla Structural Designer, use 

the same File → Import → Tekla Structural Designer command and instructions as detailed 

in Section 4.5 

The exception is at the bottom of the dialog, during an update process the option to Show 

model comparison tool should be enabled. 
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4.8.3 Model Comparison Tool 

The Model Comparison Tool is used for updates into existing Tekla Structures model, 

allowing newly created, updated and deleted parts to be identified and providing change 

control to the model. 

The tool is separated into four distinct tabs :  

● Added parts 

○ Parts which are going to be added to the Tekla Structural Designer model due 

to changes made to the Tekla Structural Designer model. 

● Updated parts 

○ Parts which exist within the Tekla Structures model and have been altered by 

Tekla Structural Designer. Note this may also include alterations made to 

attributes held by the part. 

● Deleted parts 

○ Parts which exist within the Tekla Structures model but have been deleted 

within Tekla Structural Designer. 

● Unchanged parts 

○ Parts which exist within the Tekla Structures model and have not been altered 

within Tekla Structural Designer. 

The numbers held in brackets indicate the number of parts held in the particular tab. 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  80 
 

4.8.3.1 Added parts 

The Added tab lists each part on an individual basis, grouped together by object type. Each 

part will list details on the right hand pane related to the profile, material, location, offsets and 

other information. This can be read for information purposes but not altered. 

The checkboxes on the left hand pane listed against each part controls whether the part will 

be added to the model or not. 

The Add new objects option at the bottom of the dialog acts as a global switch. If disabled, 

no new parts will be generated when importing the changes from Tekla Structural Designer. 
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4.8.3.2 Updated parts 

The Updated tab lists all parts which have been altered within Tekla Structural Designer, 

grouped together by object type. Each of the parts are listed on an individual basis, with all 

details for the part shown on the right hand side. 

The current values will be shown, along with the new values identified in the incoming 

model. Where alterations have been made, the individual line of data will be highlighted and 

the altered data can be easily identified. 

The checkboxes on the left hand pane listed against each part control whether the part will 

be amended during the import process or not. 

The APPLY UPDATES checkbox on each line of updated data allows control as to whether 

the individual update should be applied or not. This allows individual changes on parts to be 

controlled providing full control over potential part alterations. 
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4.8.3.3 Deleted parts 

The Deleted tab lists each part on an individual basis with details on the right hand pane 

related to the profile, material, location, offsets and other information. This can be read for 

information purposes but not altered. 

The checkboxes on the left hand pane listed against each part controls whether the part will 

be deleted or not. 

The Delete current objects option at the bottom of the dialog acts as a global switch. If 

disabled, no parts will be deleted when importing the changes from Tekla Structural 

Designer. 

 

 
 

4.8.4 Rebar 

The options relating to rebar are exactly the same as the initial import process. It should be 

noted however that the default settings are to delete the previously imported rebar from the 

model and generate new rebar in its place. 
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4.8.5 TSD Integration representation 

After updating a model in Tekla Structures with a file from Tekla Structural Designer, it is 

possible to color the model with an predefined object representation. This colors all parts 

based on the Integration Status parameter, this will show four separate representations :  

 

● Green : New parts 

○ Parts which have been created in Tekla Structures since the initial import 

process and have not been integrated with Tekla Structural Designer yet. 

● Blue : Imported parts 

○ Parts which have been created in Tekla Structures as part of the integration 

process with Tekla Structural Designer. 

● Yellow : Updated parts 

○ Parts which have been amended by the integration process with Tekla 

Structural Designer. 

● Magenta : Unchanged parts 

○ Parts which have been integrated with Tekla Structural Designer but have not 

been altered by the most recent update. 
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5.0 Starting the workflow with Tekla Structures 

The workflow with models originating from Tekla Structures differs from the workflow 

described in section 4 as the analysis model needs to be set up within Tekla Structures prior 

to being exported. 

The model can be generally set up in locations used for detailing, and modeling from 

common intersection points is not mandatory. 

 

 
 

5.1 Overview 

The analytical model inside Tekla Structures is created using the A & D models command. 

This should be done in stages and checked to ensure analytical connectivity prior to 

performing an export to Tekla Structural Designer. 

The use of filters to control the part visibility and the analytical content should be used. This 

will be covered in the sections below. 

 

5.2 Limitations 

As the analysis model within this workflow is controlled within Tekla Structures, there are 

some  limitations with the process. 

 

● The Tekla Structures model MUST act as the master model. No changes to position 

or offset can be made within Tekla Structural Designer. 

● Alterations returning to Tekla Structures from Tekla Structural Designer are limited to 

profile size changes and material changes only. No other changes are permitted. 

● Position changes must be made within Tekla Structures, the analysis model rebuilt 

and then re-exported to Tekla Structural Designer. 

● Loads and load combinations defined within Tekla Structures are not integrated with 

Tekla Structural Designer. (Loads and load combinations are defined within Tekla 

Structural Designer itself) 
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5.3 A & D models Command 

As mentioned above, the A & D models command must be used to create the analytical 

model inside Tekla Structures. This section covers the use of this command. 

 

 
 

Note. If the Analysis & Design commands are unavailable within Tekla Structures, please 

refer to this support article :  

● https://support.tekla.com/article/enable-or-disable-analysis-design-options-in-the-

ribbon 

 

5.3.1 Overview 

In order to build a high quality analytical model, we would recommend that the model is 

generated in stages :  

● Columns and Shear Walls 

● Beams and Bracing 

● Slabs 

● Secondary items 

 

The use of Object Group - View Filters to control the visibility of objects, and Object 

Group - Selection Filters to control the analytical model contents is vital to generate a 

correctly connected model. 

Parts which should not be transferred to Tekla Structural Designer (such as ladders, 

staircases, end connections similar) can also be omitted using these filters. 

 

5.3.2 Object Group - View Filters 

To suit the stages recommended in section 5.3.1, we would also recommend that view filters 

are created in Tekla Structures covering the objects required in each of the following groups 

:  

● Columns and Shear Walls 

● Beams and Bracing 

● Slabs 

● Secondary Items 

 

https://support.tekla.com/article/enable-or-disable-analysis-design-options-in-the-ribbon
https://support.tekla.com/article/enable-or-disable-analysis-design-options-in-the-ribbon
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An alternative to this would be to disable visibility of objects which shouldn’t be included in 

any analytical model. Parts which may be included in this criteria could be :  

● Parts in Components 

● Bolts 

● Endplates, cleats and gusset plates 

● Reinforcing Bars 

● Balustrading and handrail standards 

● Ladders and staircases 

 

This list isn’t exhaustive though and should be determined on a model by model basis. 
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5.3.3 Object Group - Selection Filters 

To suit the stages recommended in section 5.3.1, we would also recommend that Object 

Group - Selection Filters are created in Tekla Structures covering the objects required in 

each of the following groups :  

● Columns and Shear Walls 

● As above plus Beams and Bracing 

● As above plus Slabs 

● As above plus Secondary parts 

● Bracing parts only 

● Secondary parts only 

 

The use of clear and defined selection filters is essential to creating effective analytical 

models within Tekla Structures. 

 

 
 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  88 
 

5.3.4 Analytical Bars and class settings 

Analytical bars are the building blocks of the Tekla Structures analytical model. In order to 

build a connected analytical model, there are a number of classes available for analytical 

bars. These different classes will behave in slightly different ways when the analytical model 

is created. 

 

Analysis Bars 

Option Description Color 

Beam Line object of two nodes. Blue 

Beam - Ignore 

 

Bar is ignored in the analysis and will not be 

exported to Tekla Structural Designer. 

Bar not shown in the model 

Column Vertical line object of two nodes. Modeled from 

bottom to top. 

Blue 

Column - Ignore Bar is ignored in the analysis and will not be 

exported to Tekla Structural Designer. 

Bar not shown in the model 

 

Bracing For bars whose analysis class is Bracing, Keep 

axis position is off by default. 

Green 

Bracing - Ignore 

 

Bar is ignored in the analysis and will not be 

exported to Tekla Structural Designer. 

Bar not shown in the model 

Secondary 

 

Line object of two nodes. 

For bars whose analysis class is Secondary, Keep 

axis position is off by default. Secondary bars snap 

to nearest nodes instead of part end nodes. 

Orange 

Secondary - Ignore 

 

Bar is ignored in the analysis and will not be 

exported to Tekla Structural Designer. 

Bar not shown in the model 

Wall - Shell 

 

 

 

Aqua 

 

Wall - Ignore 

 

Bar is ignored in the analysis and will not be 

exported to Tekla Structural Designer. 

Aqua 

Slab - Shell  Aqua 

Slab - Ignore Bar is ignored in the analysis. Bar not shown in the model 
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Where analysis bars are flagged as -ignore, the bar is no longer shown in the model. In 

order to change the analytical properties, select the physical part and use the Get analysis 

properties command. 

 

 
 

5.3.5 Generating Analysis Models 

From within the A&D models command click on the New command. 

 

 
 

This will then display the Analysis Model Properties dialog which contains a number of 

settings which need to be considered :  

● Analysis application 

○ The default option is to use Tekla Structural Designer. Keep this setting 

unchanged. 

● Analysis model name 

○ This setting defines a unique name for the analysis model. As several 

analysis models can be created, you can use a name that describes the 

portion of the physical model that you want to analyze. 

○ To define the export folder for the analysis model, click Browse for export 

folder. 

● Analysis model filter 

○ Defines which objects to include in the analysis model, based on the list of 

available selection filters. 
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● Bracing member filter 

○ Defines which of the included objects are considered to be braces. The 

analysis nodes of braces can move more freely than the ones of primary 

analysis parts when the analysis model is created. 

● Secondary member filter 

○ Defines which of the included objects are considered to be secondary 

analysis parts. The nodes of secondary analysis parts can move more freely 

than the ones of primary analysis parts when the analysis model is created. 

● Analysis model content 

○ Defines which objects are included in the analysis model. The options are: 

■ Selected parts and loads 

● Only includes selected parts and loads, and parts created by 

components, when they match the analysis model filter. 

● To later add or remove parts and loads, use the Add selected 

objects or Remove selected objects button in the Analysis 

& Design Models dialog box. 

■ Full model 

● Includes all main parts and loads, except for parts whose 

analysis class is Ignore. Tekla Structures automatically adds 

physical objects to the analysis model when they are created 

and when they match the analysis model filter. 

■ Floor model by selected parts and loads 

● Only includes selected columns, slabs, floor beams, and loads 

when they match the analysis model filter. Tekla Structures 

replaces columns in the physical model with supports. 

● Use rigid links 

○ This option allows the use of rigid links in the analysis model. As rigid links 

are handled within the Tekla Structural Designer model, keep this setting as 

Enabled for concrete parts. 

● Analysis model rules 

○ Click to create rules to define how Tekla Structures handles individual parts in 

the analysis model, and how parts are connected with each other in the 

analysis. 

● Curved beams 

○ This option defines whether beams are analyzed as curved beams or as 

straight segments.  

■ Split into straight segments 

■ Use curved member 

● Use the advanced option XS_AD_CURVED_BEAM_

SPLIT_ACCURACY_MM in the File menu → Settings → 

Advanced Options → Analysis & Design to define how 

closely straight segments follow the curved beam. 

● Consider twin profiles 

○ Defines whether twin profiles are considered as one part (Enabled) or as two 

parts (Disabled) in the analysis. 

● Member axis location 

○ Defines the location of each analysis part in relation to the corresponding 

physical part. The options are: 
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■ Neutral axis 

● The neutral axis is the analysis axis for all parts. The location 

of the analysis axis changes if the profile of the part changes. 

■ Reference axis (eccentricity by neutral axis) 

● The part reference line is the analysis axis for all parts. The 

location of the neutral axis defines axis eccentricity. 

■ Reference axis 

● The part reference line is the analysis axis for all parts. 

■ Model default 

● The analysis axis of each part is defined individually according 

to the analysis part properties. 

● To define the axis location of specific parts, use the Position 

tab in the appropriate analysis part properties dialog box. 

● If you select Neutral axis, Tekla Structures takes the part 

location and end offsets into account when it creates nodes. If 

you select either of the Reference axis options, Tekla 

Structures creates nodes at part reference points. 

● Member end release method by connection 

○ Defines whether the support conditions of parts (No) or connections (Yes) are 

used. This option is not used with integration with Tekla Structural Designer 

● Automatic update 

○ This option defines if the analysis model is updated according to the changes 

in the physical model. 

■ Yes 

● Physical model changes are considered 

■ No 

● Physical model changes are ignored 

● Model merging with analysis application 

○ This option is not relevant to integration with Tekla Structural Designer. 
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5.3.6 Checking analytical connectivity 

There are several ways to check the connectivity of the analytical model, firstly the Warning 

count held within the Analysis & Design Models dialog can be interrogated. If a positive 

number is shown on the Warning count, the Display warnings button can be selected to 

investigate the warnings further. 
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Warnings can be checked in detail by clicking on the relevant option within the dialog. 

 

 
 

Full details of the warning will be displayed including ID references of the physical and 

analytical parts. Parts can also be identified within the model by clicking on the references 

within the dialog as this will highlight the part in the model. 
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Visual checks are also available, for example clicking on the analytical nodes will also 

highlight the connecting analytical nodes, providing a quick check on the analytical model 

connectivity. 

 

 
 

The coloring of the analytical nodes can also provide an indication of the connectivity status :  

 

 

• Nodes that connect analysis parts are cyan. 

 

 

• Nodes that do not connect analysis parts are yellow. 

 

 

• Unconnected nodes are colored red. 
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5.3.7 Correcting analysis bar positions 

Analysis bars for beam, column, bracing and secondary parts can be moved in position 

using standard Tekla Structures commands. They can also be stretched by directly 

manipulating the analytical handle located at either end of the bar. 

Please note that analytical bars for slabs and walls can not be altered in position. If the 

positions of analytical bars for these items are not correct, consider deleting them and 

building the items from scratch within Tekla Structural Designer. 

 

5.3.8 Controlling the display of Node numbers and Member numbers 

The display of both Node numbers and Member numbers can be controlled by the 

switches held on the Analysis & Design ribbon. Disabling these switches can lead to a less 

congested view of the analysis model at times. 

 

 
• Display of analysis model with both Node numbers and Member numbers enabled. 

 

 



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  96 
 

 
• Display of analysis model with Node numbers disabled. 

 

 

 
• Display of analysis model with both Node numbers and Member numbers disabled. 
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5.3.9 Creating effective models (Example) 

This section covers an example of setting up an analytical model within a completed Tekla 

Structures model. 

This is the physical model used as a basis of the analysis and design model. As can be 

seen, this model contains a number of steelwork parts with columns, beams, truss parts, 

bracing and cold rolled purlins present. 

 

 
 

The first stage is to create 3 filters which will govern the analytical connectivity. The first filter 

to be created is a filter controlling the overall contents of the A&D Model. 
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The second filter will contain parts which use bracing rules for analysis wire connectivity. As 

defined in section 5.3.4., bracing analysis bars are generated with the Keep axis position 

option disabled. It may be desirable to keep the truss top boom and bottom boom parts as 

being regular members but this can be adjusted after the model has been generated. 

 

 
 

The final filter controls the secondary members, in our example this will be the purlin 

members. As defined earlier, bars whose analysis class is Secondary have the Keep axis 

position flagged as off by default. Secondary bars also snap to nearest nodes instead of 

part end nodes. 
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With the three Object Group Selection Filters created, we will generate the analysis wires 

for the columns initially. These can then be correctly located on grid intersections prior to the 

generation of the remainder of the model. We use the View Properties and isolate the 

columns using an Object Group View Filter. 

 

 
 

With the columns now isolated, we can launch the A & D models command to open the 

Analysis & Design Models command and then the New button to create the initial model. 
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With the Analysis Model Properties dialog shown change the Analysis model content to 

be Selected parts and loads, select the content visible in the model and then click on the 

OK button. 
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The analysis bars for the columns are then created. The Analysis & Design Models dialog 

also shows the Part count and Warning count. 

 

 
 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  102 
 

The analysis bars for the columns are all initially generated at the center of the physical part. 

As we would like to have the analysis bars located on grid intersections, we can move the 

bars to more suitable positions using Move and Move special commands. 
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With the positions of the column analysis bars finalized, we can now look at creating the 

remainder of the analysis model. Firstly, the Object Group - View Filter settings are 

removed and the view regenerated to show the remainder of the model. 

We also double click on the existing Analysis model to access the Analysis Model 

Properties dialog. 
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Within the dialog, we can assign our previously created object filters to the Analysis model 

filter, Bracing member filter and Secondary member filter settings. We also change the 

Analysis model content option to be Full model and click on OK to create the remainder 

of the analytical model. 

 
 

The result of the new settings is that the Part count is increased to 126 and also the 

Warning count has increased to 4. 

We can now investigate the warning messages further. 
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To access the warning messages, click on Display Warnings and then Details. In our 

example, we could investigate the warnings and try to fix the issue within Tekla Structures. 

You may also want to consider exporting the model to Tekla Structural Designer so that 

validation traps out this error and any issues can be corrected further. 

One issue to consider is that the analysis model updates as analysis bars are adjusted. 

There is a risk that correcting parts of the model can result in other areas becoming 

problematic. If receiving less than 5 warnings, consider transferring the model to Tekla 

Structural Designer and using the superior analytical tools to correct the analytical model. 
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5.4 Exporting a model from Tekla Structures to Tekla Structural 

Designer 

To export a model using the Analysis & Design Models command, click on the Export 

button at the bottom left of the dialog. Please note that this button will not be available until 

an analysis model has been generated within Tekla Structures. 

 

 
 

After clicking on Export, the Export to Tekla Structural Designer dialog will be shown. The 

export process from this point is identical to the process described in section 4.7.3. The only 

difference is that there is no Model objects option - the contents of the export are already 

defined within the analysis model. 
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5.4.1 Initial Import into Tekla Structural Designer 

The import process into Tekla Structural Designer is exactly the same as defined in section 

4.7.4. 
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5.5 Returning information from Tekla Structural Designer to Tekla 

Structures 

5.5.1 Overview 

The workflow using the Analysis & Design Models command is more restrictive when it 

comes to returning information from Tekla Structural Designer. 

Essentially, although new parts can be created within Tekla Structural Designer and 

exported to the Tekla Structures model, no parts can be adjusted in position or deleted from 

the model. 

 

5.5.2 Restrictions 

● Grids 

○ New Grids added in Tekla Structural Designer are communicated to the Tekla 

Structures model. 

○ Alterations to existing grids are also communicated to the Tekla Structures 

model, however parts located on the grids are not updated in position. 

● Beam, Column, Bracing and Secondary Parts 

○ New members created in Tekla Structural Designer are generated as new 

parts within Tekla Structures 

○ Existing parts can be updated in profile size and material grade only. No 

alterations to position, rotation, offset, heights or depths are permissible. 

● Slab and Wall Parts 

○ Slab parts may not be adjusted in length or width. Any openings located 

within the slab may not be adjusted in size. 

○ Wall parts may not be adjusted in length or height. Any openings located 

within the wall may not be adjusted in size. 

○ New openings in slabs and walls are returned to Tekla Structures from Tekla 

Structural Designer, however please note that the analytical positions may not 

be correct due to the automated way that the analysis model is created. 

● General Rules 

○ No parts may be deleted during the integration process. Parts deleted from 

the Tekla Structural Designer model will be retained within the Tekla 

Structures model. 

○ No openings may be deleted during the integration process. 
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5.5.3 Get results command 

Updates to the existing Tekla Structures Analysis and Designer Model are made with the 

Get results button held in the Analysis & Design models dialog. 

 

 
 

Using this command will launch the Tekla Structural Designer Import, this part of the process 

will run exactly as described in sections 4.4 and 4.5. Reference should be made to these 

sections . However, as also mentioned in section 4.8.2, the Show model comparison tool 

option should be enabled.  
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5.5.4 Model comparison tool 

The process of using the Model comparison tool is almost identical to as described in section 

4.8.3 and the associated subsections, however there are two differences with the dialog: 

● Updated tab 

○ Only data related to Material and Profile are displayed. All other alterations 

made to the part are ignored. 

 

 
 

● Deleted tab 

○ As parts cannot be deleted using the Get results command, no parts will ever 

be displayed on the Deleted tab. All parts flagged as being deleted within 

Tekla Structural Designer will be retained and listed under the Unchanged 

tab. 
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6.0 Managing the conversion process 

6.1 Overview 

This section covers the mapping of content between Tekla Structural Designer and Tekla 

Structures. It is split into three distinct categories: 

● Profiles 

● Material 

● Rebar grades 

 

As Tekla Structural Designer designs to specific section sizes, it is important to ensure that 

all content is recognized during the integration process. 

 

The conversion process checks that all sections and grades used in the Tekla Structural 

Designer model have an equivalent profile or material within the Tekla Structures model - 

and vice-versa. 

 

Depending on the Tekla Structural Designer region settings and the Tekla Structures 

environments used in the modeling process, the Conversion process may be automated and 

no manual intervention is required. 
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6.2 Preview Conversion 

We would strongly recommend that the three buttons relating to checking conversions are 

utilized for all import and export processes. These are:  

● Preview profile conversion 

● Preview material conversion 

● Preview rebar grade conversion* 
○ *Please note that the Preview rebar grade conversion command cannot be used if a CXL file 

has been selected. Rebar can only be imported by choosing a TSMD format file. 

 

 
 

If conversion problems are not resolved, the following issues may arise during the import 

process :  

6.2.1 Unrecognized Profiles 

● Into Tekla Structures:  

○ No part will be created during the import process. 

● Into Tekla Structural Designer:  

○ The part will be imported as an Analysis Element. Manual amendment will 

then be required to change this into a recognized section type along with 

manual amendment to the member section, alignment and material grade 

settings. 
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6.2.2 Unrecognized Material 

● Into Tekla Structures: 

○ A part will be created but material grade highlighted as an error. This will 

require manual correction on the affected parts. 

● Into Tekla Structural Designer:  

○ The material will be isolated during the import phase. The user will need to 

stipulate a recognized material type and grade before the import can be 

completed. 

6.2.3 Unrecognized Rebar Grades 

● Into Tekla Structures:  

○ Rebar is created using the bar diameters held in the TSMD file. However as 

the grade cannot be determined, the bending radii and lapping lengths are 

created to a default value and will need to be manually adjusted. 

○ If no equivalent rebar sizes are available, no rebar of that size will be 

imported. 

● Into Tekla Structural Designer:  

○ Not applicable. Transfer of Rebar is a one way process from Tekla Structural 

Designer into Tekla Structures only. 
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6.3 Correcting Profile Conversion 

After clicking on the Preview Profile Conversion command, you will be faced with the 

graphical results of the process. This is split with the Tekla Structural Designer profile name 

on the left and the corresponding Tekla Structures name on the right. 

 

 
 

Please note that for export processes, the Tekla Structures profile will be listed on the left 

and the Tekla Structural Designer name on the right. In both dialogs though, the missing 

conversions can be identified from the entries on the right hand column. 

 

 
 

Entries where no conversion can take place will be marked as --- NO MATCH ---. The user 

will then need to identify the profiles which are not recognized and create a Profile 

Conversion file. This file should provide a recognized conversion for each of the unmatched 

profiles. 

  



Integration between Tekla Structural Designer and Tekla Structures 

June 2023  115 
 

6.3.1 Creating a Profile Conversion file - Using .cxl format neutral 

Depending on whether .cxl format neutral files or .tsmd format model files have been used 

for the transfer process, the format of the conversion file will differ slightly. 

The main difference is the requirement of a section code in conversion files used with .cxl 

format neutral files.  

This section covers the creation of profile conversion files when used in conjunction with .cxl 

format neutral files. Please refer to section 6.3.2 when using .tsmd format model files for the 

integration process. 

 

• If the integration process is being run from Tekla Structural Designer to Tekla 

Structures and the file being integrated is a .cxl format neutral file, .cxl format 

conversion files must be used (see section 6.3.1). 

• If the integration process is being run from Tekla Structural Designer to Tekla 

Structures and the file being integrated is a .tsmd format model file, .tsmd format 

conversion files must be used (see section 6.3.2). 

• If the integration process is being run from Tekla Structures to Tekla Structural 

Designer and the file being integrated is a .cxl format neutral file, .cxl format 

conversion files must be used (see section 6.3.1). 

• If the integration process is being run from Tekla Structures to Tekla Structural 

Designer and the file being integrated is a .tsmd format model file, .cxl format 

conversion files must be used (see section 6.3.1). 

o Please note that no matter what format is being transferred from Tekla 

Structures to Tekla Structural Designer, .cxl format conversion files must be 

used. 

 

A profile conversion file can be created from a blank session of any text editor such as 

Notepad or Wordpad. The file simply needs to list each profile on a separate line within the 

file. 

Each line is written in a specific format :  

<TSD Export Name>#<TSD Section Code>=<TS Name> 

 

<TSD Export Name> is the profile name contained within the Tekla Structural Designer file. 

Please note that the format of the profile may not be the same as the name displayed within 

Tekla Structural Designer itself. A file of example profile name formats is shown in Appendix 

1 of this document. 

 

<TSD Section Code> is a 5 character code written into the Tekla Structural Designer model 

for all section ranges. This allows the program to differentiate sections from different regions 

where profile names may be duplicated but the section and mechanical properties differ. 

A full list of Section Codes can be found in Appendix 1 of this document. 
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<TS Name> is the profile name held within Tekla Structures. A full list of profile names can 

be found by selecting File → Catalogs → Profile Catalog within the Tekla Structures software. 

 

An example line within the conversion file could read… 

● W 18x76#10101=W18X76 

 

…and a completed file may look as follows :  

 
 

Once all of the entries have been completed, save the file and then change the extension to 

be ‘.cnv’. The file is then available for selection during the Profile Conversion phase by using 

the Profile conversion file entry. 

6.3.2 Creating a Profile Conversion file - Using .tsmd format model files 

This section covers the creation of profile conversion files when used in conjunction with 

.tsmd format model files. Please refer to section 6.3.1 when using .cxl format neutral files 

for the integration process. 

 

 

● The main difference between conversion files is the replacement of the TSD Section 

Code with the TSD Group Name. The TSD Group Name is a short description of 

the section profile and is required due to the API requirements within Tekla Structural 

Designer. 

● The second amendment is the replacement of the TSD Export Name with the TSD 

Section Name. 

● Apart from these two changes, the two file formats are similar. 

 

A profile conversion file can be created from a blank session of any text editor such as 

Notepad or Wordpad. The file simply needs to list each profile on a separate line within the 

file. 

Each line is written in a specific format :  

<TSD Section Name>#<TSD Group Name>=<TS Name> 

 

<TSD Section Name> is the section name held within Tekla Structural Designer itself. The 

names can be obtained directly from the Tekla Structural Designer model. However, a list of 

example section names formats is shown in Appendix 2 of this document. 
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<TSD Group Name> is a multi-character description written into the Tekla Structural 

Designer model for all section ranges. This allows the API within Tekla Structural Designer 

to correctly and efficiently differentiate sections and regions. 

A full list of TSD Group Names can be found in Appendix 2 of this document. 

 

<TS Name> is the profile name held within Tekla Structures. A full list of profile names can 

be found by selecting File → Catalogs → Profile Catalog within the Tekla Structures 

software. 

 

Example lines within the conversion file could read:  

● WB 700x115#AustralianSteelSectionsWeldedBeams=WB 700*115 

● WC 350x197#AustralianSteelSectionsWeldedColumns=WC 350*197 

or… 

● UPN 80#EuropeanSteelSectionsEuropeanStandardChannels=UNP80 

● UPN 100#EuropeanSteelSectionsEuropeanStandardChannels=UNP100 

● UPN 120#EuropeanSteelSectionsEuropeanStandardChannels=UNP120 

● UPN 140#EuropeanSteelSectionsEuropeanStandardChannels=UNP140 

● UPN 160#EuropeanSteelSectionsEuropeanStandardChannels=UNP160 

● UPN 180#EuropeanSteelSectionsEuropeanStandardChannels=UNP180 

● UPN 200#EuropeanSteelSectionsEuropeanStandardChannels=UNP200 

● UPN 220#EuropeanSteelSectionsEuropeanStandardChannels=UNP220 

● UPN 240#EuropeanSteelSectionsEuropeanStandardChannels=UNP240 

● UPN 260#EuropeanSteelSectionsEuropeanStandardChannels=UNP260 

● UPN 280#EuropeanSteelSectionsEuropeanStandardChannels=UNP280 

● UPN 300#EuropeanSteelSectionsEuropeanStandardChannels=UNP300 

● UPN 320#EuropeanSteelSectionsEuropeanStandardChannels=UNP320 

● UPN 350#EuropeanSteelSectionsEuropeanStandardChannels=UNP350 

● UPN 380#EuropeanSteelSectionsEuropeanStandardChannels=UNP380 

● UPN 400#EuropeanSteelSectionsEuropeanStandardChannels=UNP400 

 

Once all of the entries have been completed, save the file and then change the extension to 

be ‘.cnv’. The file is then available for selection during the Profile Conversion phase by using 

the Profile conversion file entry. 
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6.3.3 Conversion of twin profiles 

It may be noted that twin profiles such as double unequal angles are modeled differently in 

the separate software packages. In Tekla Structures, double angles are modeled using two 

separate parts whilst in Tekla Structural Designer double angles are modeled as a single 

element which specifies the joined legs and the gap distance. 

 

Due to these differences, the format of the conversion file entry follows an alternative format 

:  

<TSD Export Name>x<TSD Specified Gap>#<TSD Section Code>=<TS Name>:<TS 

Gap>(<TS Join Leg>) 

 

<TSD Specified Gap> can be found in the Profile Conversion result line. Double section 

profiles in Tekla Structural Designer work on specific gap distances which are listed as part 

of the section profile name. Please note that this can be written as either millimeters or 

decimal inches. 

 

<TS Gap> is the equivalent distance to suit the <TSD Specified Gap> value.  

● Note : This entry MUST be written in millimeters. 

 

<TS Join Leg> is only used for double unequal angle profiles. This should either be LL for 

double angle profiles joined on the longer leg and SL for angles joined on the shorter leg. 

 

Therefore some examples of double angle conversion would be as follows: 

● Double equal angle 

○ 2L 3x3x0.4375x0.375#10114=L3X3X7/16:9.525 

● Double unequal angle joined on long leg 

○ 2L 4x3x0.25x0#10115=L4X3X1/4:0(LL) 

● Double unequal angle joined on short leg 

○ 2L 2.5x3.5x0.3125x0.75#10116=L3-1/2X2-1/2X5/16:19.05(SL) 

 

Please note that the conversion of twin profiles is only supported on import processes from 

Tekla Structural Designer into Tekla Structures. Twin profiles cannot be returned back to 

Tekla Structural Designer from Tekla Structures. 
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6.3.4 Conversion of parametric profiles 

Some profiles are automatically converted and don’t require entries to be written to the 

profile conversion file. These profiles are :  

 

TSD Parametric Profiles TS Profile Shape TS Profile Subtype 

Concrete Circular Column Circular - D d 

Concrete C-section Column C Profiles - C h*b*t 

Concrete Elbow Column Folded Plates - FLDPL FLDPL.Foldplate h*b-c-a 

Concrete I-section Column1 I profiles (concrete) - II Conc.IBeam h*b*t1-s-b2*t2[-sft[-sfb]] 

Concrete L-section Column L-profiles - L h*b*t 

Concrete Parallelogram Column Irregular profiles = REC_I Beton.GSD_FugeC a-b*h 

Concrete Polygon (3 sided) Column Irregular profiles - TRI_B Beton.GSD_FugeA a1 

Concrete Polygon (Default 6 sided) Column Variable profiles - HXGON 1Gen.Hexagon b[-tpr] 

Concrete Polygon (8 sided) Column Variable profiles - OCTGON 1Gen.Octagon b-b2 

Concrete T-section Column1 T profiles (concrete) - TC CS_rect1.tc h-b-t-s[-rv[-rh]] 

Concrete Trapezium Column Irregular profiles - REC_C CS.concr1.TRPB h-b-b1[-s] 

Precast and RC Rectangular Section Plate profiles h*b 

Precast L-section Beam L-profiles - L h*b*t 

Precast Inverted L-section Beam L-profiles - L h*b*t 

Precast T-section Beam1 T profiles (concrete) - TC CS_rect1.tc h-b-t-s[-rv[-rh]] 

Steel Plated Beam I Profiles - HI h-s-t1*b1-t2*b2 

Steel Plated Column I Profiles - HI h-s-t1*b1-t2*b2 

Steel Fabsec Beam I Profiles - FABA h-s-t1*b1-t2*b2 

Westok Plated Beam I Profiles - WPB h-s-t1*b1-t2*b2 

Westok Cellular Beam2 I profiles - WESTOK 1Gen.Westok h-b1-s1-t1*h2-b2-s2-t2 

 
1 For round tripping purposes no chamfer or slope factor values can be entered. Please 

leave these at values of 0 to ensure successful interoperability. 

 
2 With the exception of the Westok Cellular section (see a separate entry dealing with 

Westok cellular beams), all of the Tekla Structures profile shapes and subtypes listed above 

also return the information correctly to Tekla Structural Designer without the need of 

manually created conversion files. 
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6.4 Correcting Material Conversion 

After clicking on the Preview Profile Conversion command, you will be faced with the 

graphical results of the process. This is split with the Tekla Structural Designer material 

name on the left and the corresponding Tekla Structures name on the right. 

Unmatched material can be determined by viewing the entries under the TEKLA 

STRUCTURES NAME Column. 

Please note that concrete material grades will be automatically generated by the import 

process. These can be found in the File → Catalogs → Material catalog dialog after the import 

process has been completed. 

 

 
 

For export processes from Tekla Structures, please note that there is no conversion process 

as such. Material names will be directly written into the created files… 
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…with any unrecognized material being identified during the import process in Tekla 

Structural Designer. The import process in Tekla Structural Designer will not complete until 

all material is mapped into recognized types and grades. 

 

 
 

Please note that for export processes, the Tekla Structures profile will be listed on the left 

and the Tekla Structural Designer name on the right. In both dialogs though, the missing 

conversions can be identified from the entries on the right hand column. 

Entries where no conversion can take place will be marked as --- NO MATCH ---. The user 

will then need to identify the profiles which are not recognized and create a Material 

Conversion file. This file should provide a recognized conversion for each of the unmatched 

profiles. 
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6.4.1 Creating a Material Conversion file 

A profile conversion file can be created from a blank session of any text editor such as 

Notepad or Wordpad. The file simply needs to list each profile on a separate line within the 

file. 

Each line is written in a specific format :  

<TSD Material Name>=<TS Material Name> 

 

<TSD Material Name> is the material name contained within the Tekla Structural Designer 

file. This will be displayed within the Material conversion preview.  

 

<TS Material Name> is the material name held within Tekla Structures. A full list of material 

names can be found by selecting File → Catalogs → Material catalog within the Tekla 

Structures software. 

 

An example line within the conversion file could read… 

● LwConc3500=3500 LWT 

 

Once all of the entries have been completed, save the file and then change the extension to 

be ‘.cnv’. The file is then available for selection during the Material Conversion phase by 

using the Material conversion file entry. 

 

6.5 Correcting Rebar Grade Conversion 

After clicking on the Review Rebar Grade Conversion command, you will be faced with the 

graphical results of the process. This is split with the Tekla Structural Designer rebar 

information in the left column and the corresponding Tekla Structures information on the 

right. 

Each line is listed with the grade reference and then the bar size, separated with a space 

character. 

 

 
 

At this stage, the rebar diameter sizes will not be flagged as an error. However, please note 

that these sizes may not exist within the Rebar catalog held within the environment. If this is 

the case, the rebar will not be imported.  

Available rebar grades and sizes within the Tekla Structures environment by accessing File 

→ Catalogs → Rebar catalog. 
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6.5.1 Creating a Rebar Grade Conversion file 

A rebar grade conversion file can be created from a blank session of any text editor such as 

Notepad or Wordpad. The file needs to be written to list the grade conversion first and then 

each affected bar size underneath indented with a tab character. 

 

<TSD Grade Name>=<TS Grade Name> 

 <TSD Size1>=<TS Size1> 

 <TSD Size2>=<TS Size2> 

 <TSD Size3>=<TS Size3> 

 

<TSD Grade Name> is the rebar grade name contained within the Tekla Structural Designer 

file. This will be displayed within the Rebar grade conversion preview.  

 

<TS Grade Name> is the rebar grade name held within Tekla Structures. A full list of rebar 

grade names can be found by selecting File → Catalogs → Rebar catalog within the Tekla 

Structures software. 

 

<TSD Size> is the rebar diameter related to the grade contained within the Tekla Structural 

Designer file. This will be displayed within the Rebar grade conversion preview. 

 

<TS Size> is the rebar diameter held within Tekla Structures. A full list of rebar diameters 

related to the grade can be found by selecting File → Catalogs → Rebar catalog within the 

Tekla Structures software. 

 

Please note that size conversion is only required when there is no direct equivalent existing 

within the Tekla Structures Rebar catalog. 

Therefore, a sample conversion file could read :  

 

● 500=SD500 

  12=13 

 20=19 
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…and this would give the following results in the Rebar grade conversion :  

 

 
 

The top line in the conversion file converts the Tekla Structural Designer grade of 500 to the 

Tekla Structures rebar grade SD500. The following lines convert the rebar sizes of 12mm 

and 20mm to 13mm and 19mm respectively. 

Please note that lines converting the 10mm, 25mm and 16mm bars are not required as 

direct equivalent sizes exist in the Rebar catalog under the SD500 grade category (see 

following image). 

 

 
 

Once all of the entries have been completed, save the file and then change the extension to 

be ‘.cnv’. The file is then available for selection during the Rebar Grade Conversion phase 

by using the Rebar grade conversion file entry. 
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Appendix 1 - Section Code References 

(for use with .cxl format neutral file integration processes) 

USA Imperial 

 

Section Code Catalog TSD Example Name 

10101 W & M W 4x13    M 3x2.9 

10103 S S 3x5.7 

10104 HP HP 8x36 

10105 Channels C 3x3.5 

10106 Misc Channels MC 3x7.1 

10107 Rectangular HSS HSS 2x1x0.125 

10107 Rectangular HSS A1085 A1085 HSS 2x1x0.1875 

10108 Square HSS HSS 16x16x0.625 

10108 Square HSS A1085 A1085 HSS 2x2x0.1875 

10109 Pipes Pipe STD x1/2 Pipe   XS x1-1/4 Pipe   XXS x2-1/2 

10110 WT, MT & ST WT 2.5x8   MT 2x3    ST 1.5x2.85 

10111 Round HSS HSS 3.500x0.188 

10111 Round HSS A1085 A1085 HSS 1.9x0.188 

10112 Angles L 2x2x0.125 

10114 Double Angles (Equal) 2L 2x2x0.125x0.375 

10115 Double Angles (long leg back to back) 2L 2.5x2x0.25x0.75 

10116 Double Angles (short leg back to back) 2L 6x8x1x0 

10117 Flats Flat 0.125x1.5 

10118 Bars Bar 0.500x0.500 

10119 Rods Rod 0.5000 

IBGJ BG Joist Girder 120BG 

IDLHJ DLH Series Joists  72DLH19 

IGJ G Joist Girder 16G 

IKCSJ KCS Series Joists 30KCS5 

IKJA K Series Joists (angle) 10K1 

IKJR K Series Joists (rod) 30K12 

ILHJ LH Series Joists 18LH02 
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IVGJ VG Joist Girder 120VG 

10177 Standard Dressed Sawn Lumber Dressed Sawn Lumber 5x5 

10178 Western Species Glued Laminated Timber Western Glulam 2.5x6 

10179 Southern Pine Glued Laminated Timber Southern Glulam 2.5x5.5 

10180 Microllam LVL 2.0E Microllam LVL 2.0E 1.75x7.5 

10181 Parallam PSL 1.8E Parallam PSL 1.8E 3.5x3.5 

10182 Parallam PSL 2.0E Parallam PSL 2.0E 3.5x9.25 

10183 TimberStrand LSL 1.3E TimberStrand LSL 1.3E 3.5x3.5 

10184 TimberStrand LSL 1.55E TimberStrand LSL 1.55E 1.75x9.25 

10185 West Fraser LVL 1.7E West Fraser LVL 1.7E 1.75x5.5 

10186 West Fraser LVL 1.8E West Fraser LVL 1.8E 1.5x5.5 

10187 West Fraser LVL 1.9E West Fraser LVL 1.9E 1.75x5.5 

10188 West Fraser LVL 2.0E West Fraser LVL 2.0E 1.75x5.5 
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USA Metric 

 

Section Code Catalog TSD Example Name 

00101 W & M W 100x19.3    M 100x4.3 

00103 S S 75x8.5 

00104 HP HP 200x53 

00105 Channels C 75x5.2 

00106 Misc Channels MC 75x10.6 

00107 Rectangular HSS HSS 50.8x25.4x3.2 

00108 Square HSS HSS 50.8x50.8x3.2 

00109 Pipes Pipe STD x13 Pipe    XS x13 Pipe    XXS x51 

00110 WT, MT & ST WT 50x9.65    MT 50x4.45    ST 37.5x4.25 

00111 Round HSS HSS 42.2x3.6 

00112 Angles L 51x51x3.2 

00114 Double Angles (Equal) 2L 51x51x3.2x19 

00115 Double Angles (long leg back to back) 2L 64x51x4.8x9 

00116 Double Angles (short leg back to back) 2L 51x64x4.8x0 

00117 Flats Flat 3.2x38.1 

00118 Bars Bar 12.7x12.7 

00119 Rods Rod 81.0 

00177 Standard Dressed Sawn Lumber Dressed Sawn Lumber 25.4x76.2 

00178 Western Species Glued Laminated Timber Western Glulam 63.5x152.4 

00179 Southern Pine Glued Laminated Timber Southern Glulam 63.5x139.7 

MBGJ BG Joist Girder 120BG 

MDLHJ DLH Series Joists  72DLH19 

MGJ G Joist Girder 16G 

MKCSJ KCS Series Joists 30KCS5 

MKJA K Series Joists (angle) 10K1 

MKJR K Series Joists (rod) 30K12 

MLHJ LH Series Joists 18LH02 

MVGJ VG Joist Girder 120VG 

00180 Microllam LVL 2.0E Microllam LVL 2.0E 45x140 

00181 Parallam PSL 1.8E Parallam PSL 1.8E 89x89 
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00182 Parallam PSL 2.0E Parallam PSL 2.0E 89x235 

00183 TimberStrand LSL 1.3E TimberStrand LSL 1.3E 89x89 

00184 TimberStrand LSL 1.55E TimberStrand LSL 1.55E 45x235 

00185 West Fraser LVL 1.7E West Fraser LVL 1.7E 45x140 

00186 West Fraser LVL 1.8E West Fraser LVL 1.8E 38x140 

00187 West Fraser LVL 1.9E West Fraser LVL 1.9E 45x140 

00188 West Fraser LVL 2.0E West Fraser LVL 2.0E 45x140 
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UK Metric 

 

Section Code Catalog TSD Example Name 

00601 Universal Beams UB 127x76x13 

00602 Universal Columns UC 152x152x23 

00603 Rolled Steel Joists RSJ 76x76x13 

00604 Asymmetric Beams 280 ASBx74 

00605 Rolled Steel Channels RSC 76x38x7 

00606 Rolled Steel Channels (Parallel) PFC 125x65x15 

00607 Cold Formed RHS RHS 40x20x2.0 

00607 Rectangular Hollow Sections RHS 50x30x2.5 

00608 Cold Formed SHS SHS 20x20x2.0 

00608 Square Hollow Sections SHS 20x20x2.0 

00609 Cold Formed CHS CHS 21.3x2.0 

00609 Circular Hollow Sections CHS 21.3x2.6 

00610 Structural Tee from UB STB 76x64x7 

00611 Structural Tee from UC STC 152x76x12 

00612 Equal Angles RSA 20x20x3 

00613 Unequal Angles RSA 30x20x3 

00614 2 Equal Angles (back to back) 2xRSA 60x60x4 

00615 2 Unequal Angles (long leg back to back) 2xRSA(LL) 60x30x5 

00616 2 Unequal Angles (short leg back to back) 2xRSA(SL) 30x60x5 

00617 Flat Bars Flat 6x40 

00621 UBP-Universal Bearing Pile H Pile 203x203x45 

00622 Strongbox 235 SHS Strongbox 235 SHS 25x25x2.0 

00623 Strongbox 235 RHS Strongbox 235 RHS 50x25x2.0 

00624 Strongbox 235 CHS Strongbox 235 CHS 26.9x2.0 

00630 Tegral Eaves Beams EB 160x2.0x5 

00631 Tegral Z Sections Z/ 125x1.3 

00632 Tegral Zeta Sections 1/ 125x1.3 

00633 Tegral Zeta2 Sections 2/ 225x1.4 

00634 Tegral C Sections C 90x2.5 

00635 Slimflor Fabricated Beams 152 SFB 23x15 
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00641 Cold Formed CHS CF CHS 21.3x2.0 

00642 Cold Formed RHS CF RHS 40x20x2.0 

00643 Cold Formed SHS CF SHS 20x20x2.0 

00645 Hybox 355 SHS Hybox 355 SHS 25x25x2.0 

00646 Hybox 355 RHS Hybox 355 RHS 50x25x2.0 

00647 Hybox 355 CHS Hybox 355 CHS 26.9x2.0 

00650 Steadmans Eaves Beams E 200x1.6x-2 

00652 Steadmans C Sections C 140x1.4 

00653 Steadmans Z Sections Z 140x1.4 

00657 Albion Sigma Sections ASB 200x1.2 

00658 Albion C Sections C 125x1.5 

00659 Albion Z Sections Z 125x1.5 

00660 Albion Eaves Beams EB 200x1.8x0 

00661 Metsec Z Sections Z 142x1.3 

00662 Metsec C Sections C 142x1.3 

00663 Metsec Eaves Beams E 170x2.0x5 

00664 Kingspan MultiBeam Sections M 145x1.2 

00665 Kingspan MultiChannel Sections L 145x1.2 

00666 Kingspan Eaves Beams E 185x1.4x3 

00667 Hi-Span C Sections C 127x1.6 

00669 Hi-Span Eaves Beams E 170x2.0x0 

00670 Hi-Span Z Sections Z 156x1.4 

00671 Sawn Softwood 2x38x75 

00672 Planed all Round Softwood (Constructional Timber) 33x72 

00673 Regularised Softwood 36x72 

00674 Surfaced Softwood (North American Origin) 38x38 

00675 Sawn Hardwood 38x75 

00676 Surfaced Hardwood (Constructional timber) 35x72 

00677 Structural Sections UltraBeam Sections C 145x1.2 

00678 Structural Sections Eaves Beams 200x1.8x2 

00679 Structural Sections UltraZed Sections 145x1.2 

00680 Ayrshire Eaves Beams EB 160x2.0x5 

00681 Ayrshire Z Sections Z/ 125x1.3 
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00682 Ayrshire Zeta Sections 1/ 125x1.3 

00683 Ayrshire Zeta2 Sections 2/ 225x1.4 

00684 Ayrshire Swage Beams SB 220x1.2 

00685 Ayrshire Steel Framing - C Sections CS 70x1.2 

00686 Ayrshire C Sections C 90x2.5 
C 100x2.0 

00694 Advance UKB UKB 127x76x13 

00695 Advance UKC UKC 152x152x23 

00696 Advance UKPFC UKPFC 430x100x64 

00629 Glulam Glulam 65x135 

00636 Kerto-S LVL Kerto-S LVL 39x200 

00637 Parallam PSL 2.0E Parallam PSL 2.0E 89x89 

00638 TimberStrand LSL 1.3E TimberStrand LSL 1.3E 89x89 

00639 TimberStrand LSL 1.5E TimberStrand LSL 1.5E 45x184 

00640 Versa-Lam LVL Versa-Lam LVL 45x140 
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European Metric 

 

Section Code Catalog TSD Example Name 

00405 European Standard Channels UPN 80 

00406 European Parallel Flange Channels UAP 300 

00407 European Rectangular Hollow Sections Euro RHS 50x25x2.5 

00408 European Square Hollow Sections Euro SHS 20x20x2.0 

00409 European Circular Hollow Sections Euro CHS 21.3x2.3 

00412 European Equal Angles Euro A 20x20x3 

00413 European Unequal Angles Euro A 30x20x3 

00414 European 2 Equal Angles (back to back) Euro 2xA 60x60x5 

00415 European 2 Unequal Angles (long leg back to back) Euro 2xA(LL) 60x30x5 

00416 European 2 Unequal Angles (short leg back to back) Euro 2xA(SL) 30x60x5 

00421 Parallel Faced Flange Beams IPE 80 A    IPE 200 O    IPE 750 x 173 

00422 Wide/Very Wide Flange Beams HE 100 AA    HE 1000 M    
HE 1000 x 393    HL 920 x 342 

00423 Wide Flanged Columns HD 260x54.1 

00424 European Standard Beams IPN 80 
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Singapore / Malaysia 

 

Section Code Catalog TSD Example Name 

00701 I Sections (Perwaja) I 200x100x26 

00702 H Sections (Perwaja) H 150x150x31 

00705 C Sections (Perwaja) C 150x75x18 

00712 A Sections (Perwaja) A 125x125x10 

00901 UB Sections (Continental) I 100x50x9.3 

00902 UC Sections (Continental) I 100x100x14.8 

00905 Rolled Steel Channels (Continental) RSC 50x25x3.86 

00906 Rolled Steel Channels (Parallel) (Continental) PFC 100x50x10.2 

00907 Rectangular Hollow Sections (Continental) RHS 50x25x2.5 

00908 Square Hollow Sections (Continental) SHS 20x20x2.0 

00909 Circular Hollow Sections (Continental) CHS 21.3x2.3 

00910 Structural Tee from metric UB (Continental) STB 75x75x7 

00911 Structural Tee from metric UC (Continental) STC 50x100x8.5 

00912 Equal Angles (Continental) RSA 20x20x3.0 

00913 Unequal Angles (Continental) RSA 63x38x4.5 

00917 Flat Bars (Continental) Flat 3.0x12 

00918 Bars (Continental) Bar  9x9 

00919 Rods (Continental) Rod  6 

10910 Structural Tee from imperial UB (Continental) STB 75x75x7 

10911 Structural Tee from imperial UC (Continental) STC 50x100x8.5 
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Australian Metric 

 

Section Code Catalog TSD Example Name 

00201 Universal Beams UB 150x14 

00202 Universal Columns UC 100x14.8 

00203 Tapered Flange Beams TFB 100 

00205 Taper Flange Channels TFC 75 

00206 Parallel Flange Channels PFC 75 

00207 Rectangular Hollow Sections C350 RHS 50x20x1.6 

00208 Square Hollow Sections C350 SHS 13x13x1.8 

00209 Circular Hollow Sections C250 CHS 13.5x2.3 

00210 Tee from Universal Beams BT 75x7.0 

00211 Tee from Universal Columns CT 50x7.4 

00212 Equal Angles EA 25x25x3 

00213 Unequal Angles UA 65x50x5 

00214 2 Equal Angles (back to back) 2xEA 55x55x5 

00215 2 Unequal Angles (long leg back to back) 2xUEA(LL) 65x50x5 

00216 2 Unequal Angles (short leg back to back) 2xUEA(SL) 50x65x5 

00217 Flat Bars Flat 3x16 

00241 Circular Hollow Sections C350 CHS 21.3x2 

00242 Rectangular Hollow Sections C450 RHS 50x20x1.6 

00243 Square Hollow Sections C450 SHS 13x13x1.8 

00251 Welded Beams WB 700x115 

00252 Welded Columns WC 350x197 

00260 Bluescope Lysaght Eaves Beams FP 230x19x-6 

00261 Bluescope Lysaght Z Sections Z 100x10 

00262 Bluescope Lysaght C Sections C 100x10 
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South Africa Metric 

 

Section Code Catalog TSD Example Name 

01001 Universal Beams UB 203x133x25 

01002 Universal Columns UC 152x152x23 

01005 Channels (Taper Flange) TFC 76x38 

01006 Channels (Parallel Flange) PFC 100x50 

01007 Rectangular Hollow Sections RHS 50x25x2.5 

01008 Square Hollow Sections SHS 38x38x2.5 

01009 Circular Hollow Sections CHS 48.4x2.5 

01012 Equal Angles RSA 25x25x3 

01013 Unequal Angles RSA 65x50x6 

01014 2 Equal Angles (back to back) 2xRSA 60x60x4 

01015 2 Unequal Angles (long leg back to back) 2xRSA(LL) 65x50x6 

01016 2 Unequal Angles (short leg back to back) 2xRSA(SL) 50x65x6 

01021 Parallel Flange Beams IPE 100 
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Indian Metric 

 

Section Code Catalog TSD Example Name 

01101 ISMB Sections MB 100 

01102 ISJB Sections JB 150 

01103 ISLB Sections LB 75 

01104 ISWB Sections WB 600x134 

01105 ISSC Sections SC 100 

01106 ISHB Sections HB 150+x30.6 

01107 ISMC Sections MC 250+x34.2 

01108 ISJC Sections JC 100 

01109 ISLC Sections LC 75 

01110 ISMCP (Parallel) MCP 75 

01111 ISC (back to back) 2B LC 75x0 

01112 ISC (face to face) 2 F to F LC 75 

01113 IS Tee Bar HT 75 

01114 Rectangular Hollow Sections RHS 50.0x25.0x2.9 

01115 Square Hollow Sections SHS 25.0x25.0x2.6 

01116 Circular Hollow Sections 15L 

01117 Equal Angles ISA 20x20x3 

01118 Unequal Angles ISA 40x20x3 

01119 2 Equal Angles (back to back) 2L 20x20x3x0 

01120 2 Unequal Angles (long leg back to back) 2L 65x45x5x0 

01121 2 Unequal Angles (short leg back to back) 2S 45x65x5x0 

01122 ISMB and ISWB Sections with top and bottom flange plates HB 150x27.1 TBFP 
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Canadian Metric 

 

Section Code Catalog TSD Example Name 

00301 W W 100x19 

00302 M M 100x8.9 

00303 S S 75x8 

00304 HP HP 200x54 

00305 Channels C 75x5 

00306 Misc Channels MC 150x17.9 

00307 Rectangular Tubes HSS 51x25x3.2 

00308 Square Tubes HSS 38x38x3.2 

00309 Pipes HSS 48x3.2 

00310 Tee from Wide Flange Shapes WT 50x9.5 

00312 Angles L 19x19x3.2 

00314 Double Angles (Equal) 2L 19x19x3.2x0 

00315 Double Angles (Long leg back to back) 2L 51x38x3.2x20 

00316 Double Angles (short leg back to back) 2L 38x51x3.2x8 

00322 Super Light Beams SLB 55x6.4 

00321 Wide Flange Shapes WWF 350x137 

00311 WWT Shapes WWT 175x68.5 

00323 Rectangular ASTM Tubes HA 51x25x3.2 

00324 Square ASTM Tubes HA 38x38x3.2 

00325 ASTM Pipes HA 48x3.2 
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Japanese Metric 

 

Section Code Catalog TSD Example Name 

00501 Universal Beams UB 100x50x9.3 

00502 Universal Columns UC 100x100x17.2 

00503 Rolled Steel Joists RSJ 100x75x12.9 

00505 Rolled Steel Channels RSC 75x40x6.92 

00507 Rect Hollow Sections RHS 50x20x1.6 

00508 Square Hollow Sections SHS 40x40x1.6 

00509 Circ Hollow Sections CHS 21.7x2 

00512 Equal Angles EA 25x25x3 

00513 Unequal Angles UEA 90x75x9 
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Chinese Metric 

 

Section Code Catalog TSD Example Name 

00801 I Sections I 148x100x21.4 

00802 H Sections H 100x100x17.2 

00803 Joist Sections I 100x68x11.26 

00805 Channel Sections C 50x37x5.44 

00807 Rectangular Hollow Sections RHS 50x30x2.5 

00808 Square Hollow Sections SHS 25x25x1.5 

00812 Equal Angles RSA 40x40x4 

00813 Unequal Angles RSA 63x40x5 
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Hyundai 

 

Section Code Catalog TSD Example Name 

01401 Hyundai M (Korean, Japanese '90 sections) M 100x100x17.2 

01402 Hyundai M (Japanese '94, '08 sections) M 100x100x16.9 

01403 Hyundai ASTM (US sections) ASTM W 4x4x13 

01404 Hyundai HE (European sections) HE 100A 

01405 Hyundai IPE (European sections) IPE 120A 

01406 Hyundai HD (European sections) HD 260x68.2 

01407 Hyundai HP (European sections) HP 200x53.5 

01408 Hyundai UB (BS sections) BS UB 203x102x23 

01409 Hyundai UC (BS sections) BS UC 152x152x23 

01410 Hyundai UBP (BS sections) BS UBP 203x203x54 

01411 Hyundai UB (AS/NZS sections) AS/NZS UB 150x14 

01412 Hyundai UC (AS/NZS sections) AS/NZS UC 100x15 

01413 Hyundai HP (Korean sections) KS HP 200x200x56.2 

01414 Hyundai ASTM HP (US sections) ASTM HP 8x8x36 

01415 Hyundai Junior Beams (Korean sections) JB 150x75x9.01 

01416 Hyundai I-Beams (Korean sections) IB 100x75x12.9 

01417 Hyundai Equal Angles (Korean and Japanese sections) L 25x25x3 

01418 Hyundai Equal Angles (European) L 25x25x3 

01419 Hyundai Unequal Angles (Korean and Japanese sections) UA 100x75x7 

01420 Hyundai Channels (Korean and Japanese sections) CN 75x40x6.92 

01421 Hyundai ASTM Channels (US sections) ASTM C 8x11.5 

01422 Hyundai Channels (European sections) UPN 200 

01423 Hyundai Parallel Flange Channels (Korean, BS and AS/NZ sections) KS PFC 150x75 
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Nippon 

 

Section Code Catalog TSD Example Name 

01201 Nippon ASTM (USA sections) ASTM W 6x6x15 

01202 Nippon UB (BS sections) BS UB 203x102x23 

01203 Nippon UC (BS sections) BS UC 152x152x23 

01204 Nippon HE (European sections) HE 320 x 71 

01205 Nippon IPE (European sections) IPE 400 x 56 

01206 Nippon UB (JIS sections) JIS UB 150x75x14 

01207 Nippon UC (JIS sections) JIS UC 100x100x17 

01208 Nippon HC400/NSTWH HC400/NSTWH 398x412x25x20 

01209 Nippon UB (AS/NZS sections) AS/NZS UB 150x14 

01210 Nippon UC (AS/NZS sections) AS/NZS UC 100x14.8 

01211 Nippon KS (Korean sections) KS 125x125x23.8 

01212 Nippon NSHYPER Beam HY400x200x9x12 
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Korean 

 

Section Code Catalog TSD Example Name 

1601 Korean Channel Sections C 75x40x5x7 

1602 Korean Circular Hollow Sections PD 10.5x2.4 

1603 Korean Equal Angles L 25x25x3 

1604 Korean H Sections H 100x50x5x7 

1605 Korean I Sections I 100x75x5x8 

1606 Korean LH Sections LH 100x60x2.3x4.5 

1607 Korean Square and Rectangular Hollow Sections TS 75x45x4 

1608 Korean T Sections CT 97x150x6x9 

1609 Korean Unequal Angles L 100x75x7 
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Taiwan 

 

Section Code Catalog TSD Example Name 

01501 I Sections I100x75x5x8 

01502 RH Sections RH100x50x5x7 

01505 Channels U75x40x5x7 

01506 Parallel Flange Channels HE 100A 

01507 Tube (rectangular) IPE 120A 

01508 Tube (square) HD 260x68.2 

01509 Pipe (circular) HP 200x53.5 

01510 Structural Tee BS UB 203x102x23 

01512 Equal-Legged BS UC 152x152x23 

01513 Unequal-Legged BS UBP 203x203x54 

01514 DL (Equal-Legged) AS/NZS UB 150x14 

01515 DL (Unequal-Legged) (Long-side connected) AS/NZS UC 100x15 

01516 DL (Unequal-Legged) (Short-side connected) KS HP 200x200x56.2 

01551 BH Sections ASTM HP 8x8x36 
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Thailand 

 

Section Code Catalog TSD Example Name 

01701 I Sections I100x75x12.9 

01702 H Sections H100x100x17.2 

01705 Channels C125x65x13.4 

01707 Rectangular Tubes RHS75x40x3.0 

01708 Square Tubes SHS38x38x2.0 

01709 Pipe Sections Pipe60.5x3.0 

01712 Equal Angles Eq65x65x5 
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Appendix 2 - Group Name References 

(for use with .tsmd format model file integration processes) 

USA Imperial 

TSD Group Name TSD Section Name TS Name 

UsSteelSectionsUsAngles L 2-1/2x1-1/2x3/16 L2-1/2X1-1/2X3/16 

UsSteelSectionsUsChannels C 10x15.3 C10X15.3 

UsSteelSectionsUsDoubleAnglesEqual 2L 2x2x1/8x0 L2X2X1/8:0 

UsSteelSectionsUsDoubleAnglesLongLegBackToBack 2L 2-1/2x2x3/16x0 L2-1/2X2X3/16:0(LL) 

UsSteelSectionsUsDoubleAnglesShortLegBackToBack 2L 2x2-1/2x3/16x0 L2-1/2X2X3/16:0(SL) 

UsSteelSectionsUsHp HP 10x42 HP10X42 

UsSteelSectionsUsMiscChannels MC 10x22 MC10X22 

UsSteelSectionsUsPipes Pipe STD 1/2 PIPE1/2STD 

UsSteelSectionsUsRectangularHss HSS 10x2x1/8 HSS10X2X1/8 

UsSteelSectionsUsRoundHss HSS 1.66x0.140 HSS1.660X0.140 

UsSteelSectionsUsS S 10x25.4 S10X25.4 

UsSteelSectionsUsSquareHss HSS 10x10x3/16 HSS10X10X3/16 

UsSteelSectionsUsWAndM W 10x100 W10X100 

UsSteelSectionsUsWtMtSt WT 10.5x100.5 WT10.5X100.5 

SteelJoistsDlhSeriesJoists 52DLH10   52DLH10SP 52DLH10   52DLH10 

SteelJoistsKSeriesJoistsAngle 10K1 10K1 

SteelJoistsKcsSeriesJoists 10KCS1 10KCS1 

SteelJoistsLhSeriesJoists 18LH02 18LH02 
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USA Metric 

TSD Group Name TSD Section Name TS Name 

UsSteelSectionsSiAngles L 102x102x11.1 L102X102X11.1 

UsSteelSectionsSiChannels C 100x10.8 C100X10.8 

UsSteelSectionsSiDoubleAnglesEqual 2L 102x102x11.1x0 L102X102X11.1:0 

UsSteelSectionsSiDoubleAnglesLongLegBackToBack 2L 102x76x12.7x0 L102X76X12.7:0(LL) 

UsSteelSectionsSiDoubleAnglesShortLegBackToBack 2L 102x152x11.1x0 L152X102X11.1:0(SL) 

UsSteelSectionsSiHp HP 200x53 HP200X53 

UsSteelSectionsSiMiscChannels MC 75x10.6 MC75X10.6 

UsSteelSectionsSiPipes Pipe STD 15 PIPE15STD 

UsSteelSectionsSiRectangularHss HSS 101.6x50.8x3.2 HSS101.6X50.8X3.2 

UsSteelSectionsSiRoundHss HSS 101.6x3.2 HSS101.6X3.2 

UsSteelSectionsSiS S 100x11.5 S100X11.5 

UsSteelSectionsSiSquareHss HSS 101.6x101.6x3.2 HSS101.6X101.6X3.2 

UsSteelSectionsSiWAndM W 1000x222 W1000X222 

UsSteelSectionsSiWtMtSt ST 100x13.7 ST100X13.7 
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UK Metric 

TSD Group Name TSD Section Name TS Name 

UkColdFormedSectionsColdFormedChs CF CHS 21.3x2.0 CF-CHS21.3*2.0 

UkColdFormedSectionsColdFormedRhs CF RHS 40x20x2.0 CF-RHS40*20*2.0 

UkColdFormedSectionsColdFormedShs CF SHS 20x20x2.0 CF-SHS20*20*2.0 

UkColdRolledSectionsAlbionCSections C 125x1.5 ALB-C12515 

UkColdRolledSectionsAlbionEavesBeams EB 200x1.8x0 ALB-EB20018+00 

UkColdRolledSectionsAlbionSigmaSections ASB 200x1.2 ALB-SIGMA-20012 

UkColdRolledSectionsAlbionZSections Z 125x1.5 ALB-ZED-12515 

UkColdRolledSectionsAyrshireCSections C 90x2.5 AYR-C9025 

UkColdRolledSectionsAyrshireEavesBeams EB 160x2.0x0 AYR-EB16020+00 

UkColdRolledSectionsAyrshireSteelFramingCSections CS 70x1.2 AYR-CS7012 

UkColdRolledSectionsAyrshireSwageBeam SB 220x1.2 AYR-SWAGE-SB22012 

UkColdRolledSectionsAyrshireZSections Z/ 125x1.3 AYR-ZED-12513 

UkColdRolledSectionsAyrshireZeta2Sections 2/ 225x14 AYR-ZETAII-22514 

UkColdRolledSectionsAyrshireZetaSections 1/ 125x1.3 AYR-ZETA-12513 

UkColdRolledSectionsHiSpanCSections 
C 127x1.5  
C 156x1.3 

HIS-MC12715   HIS-
CC15613 

UkColdRolledSectionsHiSpanEavesBeams E 170x2.0x0 HIS-EB17020+00 

UkColdRolledSectionsHiSpanZSections Z 156x1.3 HIS-ZED-15613 

UkColdRolledSectionsKingspanEavesBeams E 185x1.4x-10 KINGSPAN-E185140-10 

UkColdRolledSectionsKingspanMultiBeamSections M 145x1.2 KINGSPAN-M145065120 

UkColdRolledSectionsKingspanMultiChannelSections L 145x1.2 KINGSPAN-L145070120 

UkColdRolledSectionsMetsecCSections C 142x1.3 MET-2-142C13 

UkColdRolledSectionsMetsecEavesBeams E 170x2.0x0 MET-2-EB170E20+0 

UkColdRolledSectionsMetsecZSections Z 142x1.3 MET-2-142Z13 

UkColdRolledSectionsSteadmansCSections C 300x3.0 STEAD-C-30030 

UkColdRolledSectionsSteadmansEavesBeams E 200x1.6x0 STEAD-EB20016+0 

UkColdRolledSectionsSteadmansZSections Z 140x1.4 STEAD-Z-14014 

UkColdRolledSectionsStructuralSectionsEavesBeams 200x1.8x0 ULT-EBM-2009018+00 

UkColdRolledSectionsStructuralSectionsUltraBeamSections C 145x1.2 ULT-RBM-1456312 

UkColdRolledSectionsStructuralSectionsUltraZedSections 145x1.2 ULT-ZED-145120 

UkSteelSections2EqualAnglesBackToBack 2xRSA 100x100x10 RSA100*100*10:8 

UkSteelSections2UnequalAnglesLongLegBackToBack 2xRSA(LL) 100x50x10 L100*50*10:8(LL) 

UkSteelSections2UnequalAnglesShortLegBackToBack 2xRSA(SL) 50x100x10 L100*50*10:8(SL) 

UkSteelSectionsAdvanceUkb UKB 1016x305x222 UKB1016*305*222 

UkSteelSectionsAdvanceUkc UKC 356x368x129 UKC356*368*129 

UkSteelSectionsAdvanceUkpfc UKPFC 100x50x10 UKPFC-100*50*10 

UkSteelSectionsAsymmetricBeams 280 ASB 100 ASB280*100 

UkSteelSectionsCircularHollowSections CHS 21.3x2.6 CHS21.3*2.6 

UkSteelSectionsEqualAngles RSA 20x20x3 RSA20*20*3 

UkSteelSectionsFlatBars Flat 10x100 FLT100*10 

UkSteelSectionsRectangularHollowSections RHS 50x30x2.5 RHS50*30*2.5 

UkSteelSectionsRolledSteelChannels RSC 102x51x10 C102*51*10 

UkSteelSectionsRolledSteelChannelsParallel PFC 100x50x10 PFC-100*50*10 
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UkSteelSectionsRolledSteelJoists RSJ 76x76x13 RSJ76*76*12.65 

UkSteelSectionsSquareHollowSections SHS 20x20x2.0 SHS20*20*2.0 

UkSteelSectionsStructuralTeeFromUb STB 76x64x7 TEE76*64*7 

UkSteelSectionsStructuralTeeFromUc STC 152x76x12 TEE152*76*12 

UkSteelSectionsUnequalAngles RSA 30x20x3 RSA30*20*3 

UkSteelSectionsUniversalBeams UB 1016x305x222 UB1016*305*222 

UkSteelSectionsUniversalColumns UC 152x152x23 UC152*152*23 

UkTimberSectionsPlanedAllRoundSoftwood 
(Constructional Timber) 
33x72 72*33 

UkTimberSectionsRegularisedSoftwood 36x72 72*36 

UkTimberSectionsSawnHardwood 38x75 75*38 

UkTimberSectionsSawnSoftwood 2x38x75 75*76 

UkTimberSectionsSurfacedHardwood 
(Constructional timber) 
35x72 72*35 

UkTimberSectionsSurfacedSoftwood 
(North American Origin) 
38x38 38*38 
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European Metric 

TSD Group Name TSD Section Name TS Name 

EuropeanSteelSectionsEuropean2EqualAnglesBackToBack Euro 2xA 60x60x5 L60*5:8 

EuropeanSteelSectionsEuropean2UnequalAnglesLongLegBackToBack Euro 2xA(LL) 60x30x5 L60*30*5:8(LL) 

EuropeanSteelSectionsEuropean2UnequalAnglesShortLegBackToBack Euro 2xA(SL) 30x60x5 L60*30*5:8(SL) 

EuropeanSteelSectionsEuropeanCircularHollowSections Euro CHS 21.3x2.3 HFCHS21.3*2.3 

EuropeanSteelSectionsEuropeanEqualAngles Euro A 20x20x3 L20*3 

EuropeanSteelSectionsEuropeanParallelFlangeChannels UAP 80 UPE80 

EuropeanSteelSectionsEuropeanRectangularHollowSections Euro RHS 50x25x2.5 HFRHS50*25*2.5 

EuropeanSteelSectionsEuropeanSquareHollowSections Euro SHS 20x20x2.0 HFSHS20*20*2.0 

EuropeanSteelSectionsEuropeanStandardBeams IPN 80 INP80 

EuropeanSteelSectionsEuropeanStandardChannels UPN 80 UPN80 

EuropeanSteelSectionsEuropeanUnequalAngles Euro A 30x20x3 L30*20*3 

EuropeanSteelSectionsParallelFacedFlangeBeams IPE 80 AA IPEAA80 

EuropeanSteelSectionsWideFlangedColumns HD 260x54.1 HD260*54,1 

EuropeanSteelSectionsWideVeryWideFlangedBeams 
HE 100 AA 
HL 920 x 342 

HEAA100 
HL920*342 
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Singapore / Malaysia 

TSD Group Name TSD Section Name TS Name 

PerwajaSteelSectionsASectionsPerwaja A 125x125x10 A 125X125X10 

PerwajaSteelSectionsBarsContinental Bar 9x9 PLT9*9 

PerwajaSteelSectionsCSectionsPerwaja C 150x75x18 C 150X75X18 

PerwajaSteelSectionsCircularHollowSectionsContinental CHS 21.3x2.3 CHS 21.3X2.3 

PerwajaSteelSectionsEqualAnglesContinental RSA 20x20x3.0 RSA 20X20X3.0 

PerwajaSteelSectionsFlatBarsContinental Flat 3.0x12 PLT3.0*12 

PerwajaSteelSectionsHSectionsPerwaja H 150x150x31 H 150X150X31 

PerwajaSteelSectionsISectionsPerwaja I 200x100x26 I 200X100X26 

PerwajaSteelSectionsRectangularHollowSectionsContinental RHS 50x25x2.5 RHS 50X25X2.5 

PerwajaSteelSectionsRodsContinental Rod 6 ROD6 

PerwajaSteelSectionsRolledSteelChannelsContinental RSC 50x25x3.86 RSC 50X25X3.86 

PerwajaSteelSectionsRolledSteelChannelsParallelContinental PFC 100x50x10.2 PFC 100X50X10.2 

PerwajaSteelSectionsSquareHollowSectionsContinental SHS 20x20x2.0 SHS 20X20X2.0 

PerwajaSteelSectionsStructuralTeeFromMetricUbContinental STB 75x75x7 STB 75X75X7 

PerwajaSteelSectionsStructuralTeeFromMetricUcContinental STB 457x508x222 STB 457X508X222 

PerwajaSteelSectionsUbSectionsContinental I 100x50x9.3 I 100X50X9.3 

PerwajaSteelSectionsUcSectionsContinental I 100x100x14.8 I 100X100X14.8 

PerwajaSteelSectionsUnequalAnglesContinental RSA 63x38x4.5 RSA 63X38X4.5 
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Australian Metric 

TSD Group Name TSD Section Name TS Name 

AustralianColdRolledSectionsBluescopeLysaghtCSections C 100x10 BS-C10010 

AustralianColdRolledSectionsBluescopeLysaghtEavesBeams FP 230x19x-6 BS-FP23019-6 

AustralianColdRolledSectionsBluescopeLysaghtZSections Z 100x10 BS-Z10010 

AustralianHollowSteelSectionsCircularHollowSectionsC250 CF CHS 21.3x2.6 CHS21.3*2.6 

AustralianHollowSteelSectionsCircularHollowSectionsC350 CF CHS 21.3x2 CHS21.3*2.0 

AustralianHollowSteelSectionsRectangularHollowSectionsC350 CF RHS 50x20x1.6 RHS50*20*1.6 

AustralianHollowSteelSectionsRectangularHollowSectionsC450 CF RHS 50x20x1.6 RHS50*20*1.6 

AustralianHollowSteelSectionsSquareHollowSectionsC350 CF SHS 13x13x1.8 SHS13*13*1.8 

AustralianHollowSteelSectionsSquareHollowSectionsC450 CF SHS 13x13x1.8 SHS13*13*1.8 

AustralianSteelSections2EqualAnglesBackToBack 2xEA 55x55x5 EA55*55*5:8 

AustralianSteelSections2UnequalAnglesLongLegBackToBack 2xUEA(LL) 65x50x5 UA65*50*5:8(LL 

AustralianSteelSections2UnequalAnglesShortLegBackToBack 2xUEA(SL)50x65x5 UA65*50*5:8(SL 

AustralianSteelSectionsEqualAngles EA 25x25x3 EA25*25*3 

AustralianSteelSectionsFlatBars Flat 3x16 FLT3*16 

AustralianSteelSectionsParallelFlangeChannels PFC 75 PFC75*40 

AustralianSteelSectionsTaperFlangeChannels TFC 125 TFC125*65 

AustralianSteelSectionsTaperedFlangeBeams TFB 100 TFB100*7 

AustralianSteelSectionsTeeFromUniversalBeams BT 75x7.0 BT75*7 

AustralianSteelSectionsTeeFromUniversalColumns CT 50x7.4 CT50*7 

AustralianSteelSectionsUnequalAngles UA 65x50x5 UA65*50*5 

AustralianSteelSectionsUniversalBeams UB 150x14  

AustralianSteelSectionsUniversalColumns UC 100x14.8 UC100*15 
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South Africa Metric 

TSD Group Name TSD Section Name TS Name 

SouthAfricanSteelSections2EqualAnglesBackToBack 2xRSA 60x60x4 L60*60*4:8 

SouthAfricanSteelSectionsCircularHollowSections CHS 60.3x2.5 CHS60.3*2.5 

SouthAfricanSteelSectionsEqualAngles RSA 25x25x3 L25*25*3 

SouthAfricanSteelSectionsParallelFlangeBeams IPE AA 100 IPEAA100 

SouthAfricanSteelSectionsRectangularHollowSections RHS 50x25x2.5 RHS50*25*2.5 

SouthAfricanSteelSectionsSquareHollowSections SHS 38x38x2.5 SHS38*38*2.5 

SouthAfricanSteelSectionsUnequalAngles RSA 65x50x6 L65*50*6 

SouthAfricanSteelSectionsUniversalBeams UB 203x133x25 UB203*133*25 

SouthAfricanSteelSectionsUniversalColumns UC 152x152x23 UC152*152*23 

 

Indian Metric 

TSD Group Name TSD Section Name TS Name 

IndianStructuralSections2EqualAnglesBackToBack 2L 50x50x3x0 ISA50X50X3:0 

IndianStructuralSections2UnequalAnglesLongLegBackToBack 2L 65x45x5x0 ISA65X45X5:0(LL) 

IndianStructuralSections2UnequalAnglesShortLegBackToBack 2S 45x65x5x0 ISA65X45X5:0(SL) 

IndianStructuralSectionsCircularHollowSections 15H 15H 

IndianStructuralSectionsEqualAngles ISA 20x20x3 ISA20X20X3 

IndianStructuralSectionsIsTeeBar HT 75 ISHT75 

IndianStructuralSectionsIshbSections HB 150 ISHB150 

IndianStructuralSectionsIsjbSections JB 150 ISJB150 

IndianStructuralSectionsIsjcSections JC 100 ISJC100 

IndianStructuralSectionsIslbSections LB 75 ISLB75 

IndianStructuralSectionsIslcSections LC 75 ISLC75 

IndianStructuralSectionsIsmbSections MB 100 ISMB100 

IndianStructuralSectionsIsmcSections MC 75 ISMC75 

IndianStructuralSectionsIsmcpParallel MCP 75 ISMCP75 

IndianStructuralSectionsIsscSections SC 100 ISSC100 

IndianStructuralSectionsIswbSections WB 150 ISWB150 

IndianStructuralSectionsRectangularHollowSections RHS 50.0x25.0x3.2 TSR50X25X3.2 

IndianStructuralSectionsSquareHollowSections SHS 25.0x25.0x2.6 TSS25X2.6 

IndianStructuralSectionsUnequalAngles ISA 70x45x5 ISA70X45X5 
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Canadian Metric 

TSD Group Name TSD Section Name TS Name 

CanadianSteelSectionsAngles L 19x19x3.2 L19X19X3.2 

CanadianSteelSectionsChannels C 75x5 C75X5 

CanadianSteelSectionsDoubleAnglesEqual 2L 19x19x3.2x0 L19X19X3.2:0 

CanadianSteelSectionsDoubleAnglesLongLegBackToBack 2L 51x38x3.2x0 L51X38X3.2:0(LL) 

CanadianSteelSectionsDoubleAnglesShortLegBackToBack 2L 38x51x3.2x0 L51X38X3.2:0(SL) 

CanadianSteelSectionsHp HP 200x54 HP200X54 

CanadianSteelSectionsM M 100x8.9 M100X8.9 

CanadianSteelSectionsMiscChannels MC 150x17.9 MC150X17.9 

CanadianSteelSectionsPipes HSS 48x3.2 HSS48X3.2 

CanadianSteelSectionsRectangularTubes HSS 51x25x3.2 HSS51X25X3.2 

CanadianSteelSectionsS S 75x8 S75X8.5 

CanadianSteelSectionsSquareAstmTubes HA 38x38x3.2 HSS38X38X3.2 

CanadianSteelSectionsSquareTubes HSS 64x64x3.2 HSS64X3.2 

CanadianSteelSectionsW W 100x19 W100X19.3 

 

Japanese Metric 

TSD Group Name TSD Section Name TS Name 

JapaneseSteelSectionsCircularHollowSections CHS 21.7x2 ›21.7*2 

JapaneseSteelSectionsEqualAngles EA 25x25x3 L25*25*3 

JapaneseSteelSectionsRectangularHollowSections RHS 50x20x1.6 STKR50*20*1.6 

JapaneseSteelSectionsRolledSteelJoists RSJ 100x75x12.9 I-100X75X5X8 

JapaneseSteelSectionsSquareHollowSections SHS 40x40x1.6 STKR40*40*1.6 

JapaneseSteelSectionsUnequalAngles UEA 90x75x9 L90*75*9 

JapaneseSteelSectionsUniversalBeams UB 100x50x9.3 H100*50*5*7 

JapaneseSteelSectionsUniversalColumns UC 100x100x17.2 H100*100*6*8 
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Chinese Metric 

TSD Group Name TSD Section Name TS Name 

ChineseSteelSectionsChannelSections RSC 50x37x5.44 C5 

ChineseSteelSectionsEqualAngles RSA 40x40x4 L40*4 

ChineseSteelSectionsHSections H 100x100x17.2 H100*100*6*8 

ChineseSteelSectionsISections I 148x100x21.4 H148*100*6*9 

ChineseSteelSectionsJoistSections RSJ 100x68x11.26 I10 

ChineseSteelSectionsRectangularHollowSections RHS 50x30x2.5 F50X30X2.5 

ChineseSteelSectionsSquareHollowSections SHS 25x25x2.0 F25X25X2 

ChineseSteelSectionsUnequalAngles RSA 63x40x6 L63*40*6 
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Appendix 3 - List of created parameters 

Analysis Result Parameters 

Parameter Name Description  Notes  

TSD_AxialMax  Maximum Axial Force Applicable to Bracing parts when analysis 

results imported 

TSD_MajorMomentMax  Maximum Moment in 

Major Axis 

Populated by Column parts when analysis 

results imported 

TSD_MajorMomentMin  Minimum Moment in 

Major Axis 

Populated by Column parts when analysis 

results imported 

TSD_MajorShearMax  Maximum Shear in Major 

Axis 

Populated by Column parts when analysis 

results imported 

TSD_MajorShearMin  Minimum Shear in Major 

Axis 

Populated by Column parts when analysis 

results imported 

TSD_MinorMomentMax  Maximum Moment in 

Minor Axis 

Populated by Column parts when analysis 

results imported 

TSD_MinorMomentMin Minimum Moment in 

Minor Axis 

Populated by Column parts when analysis 

results imported 

TSD_MinorShearMax  Maximum Shear in Minor 

Axis 

Populated by Column parts when analysis 

results imported 

TSD_MinorShearMin  Minimum Shear in Minor 

Axis 

Populated by Column parts when analysis 

results imported 

TSD_VShearMax  Maximum Vertical Shear Populated by Column parts when analysis 

results imported 

TSD_VShearMin  Minimum Vertical Shear Populated by Column parts when analysis 

results imported 

TSD_EndAxialMax  Maximum Positive Axial 

on Beam End 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_EndAxialMaxNeg  Maximum Negative Axial 

on Beam End 

Populated by Beam parts without pinned ends 

when analysis results imported 
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TSD_EndMomentMax  Maximum Positive 

Moment on Beam End 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_EndMomentMaxNeg  Maximum Negative 

Moment on Beam End 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_EndVShearMax  Maximum Positive Shear 

on Beam End 

Populated by Beam parts when analysis results 

imported 

TSD_EndVShearMaxNeg  Maximum Negative Shear 

on Beam End 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_StartAxialMax  Maximum Positive Axial 

on Beam Start 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_StartAxialMaxNeg  Maximum Negative Axial 

on Beam Start 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_StartMomentMax  Maximum Positive 

Moment on Beam Start  

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_StartMomentMaxNeg  Maximum Negative 

Moment on Beam Start 

Populated by Beam parts without pinned ends 

when analysis results imported 

TSD_StartVShearMax  Maximum Positive Shear 

on Beam Start 

Populated by Beam parts when analysis results 

imported 

TSD_StartVShearMaxNeg  Maximum Negative Shear 

on Beam Start 

Populated by Beam parts without pinned ends 

when analysis results imported 

axial1 Maximum Negative Axial 

on part start 

Populates the UDA Tension, Nc : Start 

axial2  

 

Maximum Negative Axial 

on part end 

Populates the UDA Tension, Nc : End 

 

axialcomp1 

 

Maximum Positive Axial 

on part start 

Populates the UDA Compression, Nc : Start 
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axialcomp2 

 

Maximum Positive Axial 

on part end 

Populates the UDA Compression, Nc : End 

 

moment1 

 

Maximum major axis 

moment on part start 

Populates the UDA Moment, Mz (major) : Start 

 

moment2 

 

Maximum major axis 

moment on part end 

 

Populates the UDA Moment, Mz (major) : End 

 

 

momentY1  Maximum minor axis 

Moment on part start 

Populates the UDA Moment, My (minor) : Start 

momentY2 Maximum minor axis 

Moment on part end 

Populates the UDA Moment, My (minor) : End 

shear1 Maximum major axis 

Shear on part start 

Populates the UDA Shear, Vy (major) : Start 

shear2 Maximum major axis 

Shear on part end 

Populates the UDA Shear, Vy (major) : End 

shearZ1 Maximum minor axis 

Shear on part start 

Populates the UDA Shear, Vz (minor) : Start 

shearZ2 Maximum minor axis 

Shear on part end 

Populates the UDA Shear, Vz (minor) : End 

torsion1 Maximum Torsion on part 

start 

Populates the UDA Torsion, Mx : Start 

torsion2 Maximum Torsion on part 

end 

Populates the UDA Torsion, Mx : End 
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Reinforced Concrete Specific Parameters 

Parameter Name Description  Notes  

TSD_RC_BARS  Designed rebar 

requirement in column 

Populated by Concrete Column parts 

TSD_RC_BOTTOM Designed rebar 

requirement in bottom 

of beam 

Populated by Concrete Beam parts 

TSD_RC_COVER  Designed rebar cover 

requirement 

Populated by Concrete Column and Beam parts 

TSD_RC_LINKS  Designed rebar link 

requirement 

Populated by Concrete Column and Beam parts - 

TSD English UK language 

TSD_RC_SIDE  Designed rebar 

requirement in side of 

beam 

Populated by Concrete Beam parts where 

applicable. 

TSD_RC_SPAN_LINKS  Designed rebar link 

requirement  

Populated by Concrete Beam parts, only if option 

'Separate Support and Span Regions' has been 

enabled - TSD English UK language 

TSD_RC_SPAN_STIRRUPS Designed rebar stirrup 

requirement  

Populated by Concrete Beam parts, only if option 

'Separate Support and Span Regions' has been 

enabled. TSD English US language 

TSD_RC_STIRRUPS  Designed rebar stirrup 

requirement 

Populated by Concrete Column and Beam parts - 

TSD English US language 

TSD_RC_SUPP_LINKS  Designed rebar link 

requirement 

Populated by Concrete Beam parts, only if option 

'Separate Support and Span Regions' has been 

enabled - TSD English UK language 

TSD_RC_SUPP_REGION  Description of the 

Support Region extents 

Populated by Concrete Beam parts, only if option 

'Separate Support and Span Regions' has been 

enabled. 

TSD_RC_SUPP_STIRRUPS  Designed rebar stirrup 

requirement 

Populated by Concrete Beam parts, only if option 

'Separate Support and Span Regions' has been 

enabled. TSD English US language 

TSD_RC_TOP  Designed rebar 

requirement in top of 

beam 

Populated by Concrete Beam parts only 
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General Parameters 

Parameter Name Description  Notes  

Camber Precamber required for the beam Populated for applicable Beam parts. Renamed 

from TSD_CAMBER 

Class Default settings are A,B or C Populated from TSD User Defined Attribute 

File Path and filename string Populated from TSD User Defined Attribute 

Finish User defined text content Populated from TSD User Defined Attribute 

Integration Status  Integration Status of Object Populated by all objects - New / Updated / 

Unchanged settings available. Renamed from 

TSD_INTEGRATION_STATUS 

Mark Part mark assigned within TSD Populated by all objects. Renamed from parameter 

TSD_PART_MARK 

Name User defined text content Populated from TSD User Defined Attribute 

Note User defined text content Populated from TSD User Defined Attribute 

Number of Studs Total number of studs carried by 

beam 

Populated by composite beam parts. Renamed 

from TSD_TOTAL_STUDS 

Phase Default settings are 1, 2 or 3 Populated from TSD User Defined Attribute 

Transverse Rebar Transverse Reinforcement 

Requirements 

Populated by compositely designed Beam parts 

only. Renamed from TSD_TRANS_REINF 

TSD_CONCRETE_FILL Is the part a concrete filled steel 

hollow section? 

Populated when concrete filled hollow section 

columns are integrated - Yes/No answer 

TSD_DECK_GAUGE Steel decking profile gauge Populated by Composite Slab parts 

TSD_DECK_MANUF Steel decking profile manufacturer Populated by Composite Slab parts 

TSD_DECK_REF Steel decking profile name Populated by Composite Slab parts 

TSD_DESIGN_GRP  Design Group assigned in TSD Populated by all objects when used in TSD 

TSD_DETAIL_GRP  Detail Group assigned in TSD Populated by Concrete Beam and Column parts 
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TSD_EMBODIED_CARBON Represents the embodied carbon 

plus the associated object. 

Populated by all objects 

TSD_END_CONN  Connection type on end of member Populated by Beam parts. Settings of Cantilever, 

Fixed, Moment, Pinned and Unknown 

TSD_GUID GUID reference assigned to the 

object within TSD 

Populated by all objects 

TSD Member Type Part type within TSD. See 

Appendix 4 for all values. 

 

Populated by all Beam, Column and Bracing parts. 

Renamed from parameter TSD_MBR_TYPE. 

TSD_PROFILE_NAME Profile name assigned in TSD Populated by all parts 

TSD Slab Type Slab type within TSD. See 

Appendix 4 for all values. 

Populated by all Slab parts. Renamed from 

parameter TSD_SLAB_TYPE.  

TSD_SPAN_DIR Slab span direction in degrees Populated by slabs objects. Set as 0 deg for 2-way 

spanning slabs. 

TSD_START_CONN  Connection type on start of 

member 

Populated by Beam parts. Settings of Cantilever, 

Fixed, Moment, Pinned and Unknown 

TSD Wall Type Wall type within TSD. See 

Appendix 4 for all values. 

Populated by all Wall parts. Renamed from 

parameter TSD_WALL_TYPE. 
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Appendix 4 - Object Types 

Members (Parameter : TSD Member Type (TSD_MBR_TYPE)) 

Columns 

Reference Description 

SIMPLE_COLUMN Column with the simple design option checked 

GENERAL_COLUMN Column with the simple design option unchecked 

GABLE_POST Gable post member 

PILE Pile column member 

Beams and Braces 

Reference Description 

COMP_BEAM Composite beam - No edge conditions set 

EDGE_COMPOSITE_BEAM Edge condition composite beam 

INT_COMPOSITE_BEAM Internal condition composite beam 

GENERAL_BEAM Beam member 

BRACE Bracing member 

JOIST USA Joist member 

SB_CANTILEVER_A Cantilevered beam; free at start end 

SB_CANTILEVER_B Cantilevered beam; free at finish end 

GB_FREE_END_A General beam; free at start end 

GB_FREE_END_B General beam; free at finish end 

GB_FREE_BOTH_ENDS Multi-span general beam member 

WSTK_WESTOK Ribbon cut Westok beam 

WSTK_CANTILEVER_A Cantilevered Westok member; free at start end 

WSTK_CANTILEVER_B Cantilevered Westok member; free at finish end 

STEEL_JOIST USA Joist member 

ANALYSIS Analysis element 

EAVES_BEAM Eaves beam member 

RAIL Sheeting rail member 

PURLIN Purlin member 

TIE Tie member 
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Truss members 

Reference Description 

INT_TRUSS Internal truss member 

SIDE_TRUSS Side truss member 

TOP_TRUSS Top chord of truss 

BOT_TRUSS Bottom chord of truss 

 

Portal sections 

● Portal sections are imported into Tekla Structures from Tekla Structural Designer. They cannot be 

exported from Tekla Structures into Tekla Structural Designer. 

 

Reference Description 

PORTAL_COLUMN Portal frame stanchion 
(Export from Tekla Structural Designer only) 

PORTAL_RAFTER Portal frame rafter 
(Export from Tekla Structural Designer only) 

PORTAL_TIE Portal frame tie member 
(Export from Tekla Structural Designer only) 

PARAPET_POST Portal frame parapet post 
(Export from Tekla Structural Designer only) 
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Slabs (Parameter: TSD Slab Type (TSD_SLAB_TYPE)) 

 

Reference Description 

OVERHANG Slab with overhanging edge 

RC_SLAB Slab on beams (2 way spanning) 

RC_SLAB_1WAY Slab on beams (1 way spanning) 

COMP_SLAB Composite slab 

FLAT_SLAB Flat slab 

CAST_SLAB Precast slab 

STEEL_DECK Steel deck slab (2 way spanning) 

STEEL_DECK_1WAY Steel deck slab (1 way spanning) 

TIMBER_DECK Timber deck slab 

AREA_PAD Foundation mat with or without piles 

STRIP_BASE Isolated foundation under wall 

PAD_BASE Isolated foundation under column 

PILE_CAP Isolated foundation under column with piles 

COLUMN_DROP Column drop head panel 

 

Walls (Parameter: TSD Wall Type (TSD_WALL_TYPE)) 

 

Reference Description 

MESHED Reinforced concrete wall using mesh analysis method 

MID_PIER Reinforced concrete wall using mid-pier theory 

SHEAR_ONLY Shear Only Wall 

GENERAL_WALL Unreinforced general wall using mesh analysis method 
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